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Preface

Welcome to the Primavera® Analytic Applications guide.

Audience and Assumptions

Documentation for analytic applications assumes the reader is a new user of
analytic applications (Portfolio Management and Business Intelligence) but is
familiar with the business objects and functionality of Primavera products.

+ A Portfolio Management user creates portfolios of resources, projects, or
other portfolios, key performance indicators (KPIs), views, and scorecard
templ ates.

+ A Business Intelligence user provides insight about your enterprise by
sorting, pivoting, and analyzing data.

+ A Capacity Planning user provides both near and long-term analysis of
project staffing demand and resource supply.

+ Anadministrator of the analytic applicationsis responsible for maintaining,

and troubleshooting Portfolio Management, Business Intelligence, Capacity
Planning, and Data Mart.




Sources of Information

This document provides information about the analytic applications, including
descriptions of functionality and procedural instructions. The following table
lists sources of information regarding the analytic applications:

Sour ce L ocation

Online Documentation | Click Help » User Guidein the upper corner of
any page to open this Adobe Acrobat file (.PDF).
Adobe Acrobat Reader is freely available from
Adobe Systems at www.adobe.com.

Primavera s Website Please visit us at www.primavera.com.

See “ Documentation Set” on page 10.
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Documentation Conventions

This manual uses the following conventions:

Convention M eaning

Plain Text Thisisthe default font of the manual.

Green Text Indicates a cross-reference to a section containing
related information. Online, click the text to
navigate to the section.

Blue Text Indicates text that appears in the graphical user
interface, including menu items and field names.

Code Indicates code asit appears on the screen or asyou
enter it.

File» Save Indicates the next level of a menu.

Indicates an informational note.

Indicates an important warning.

Indicates a product tip.

Analytic Applications
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Documentation Set

The following documentation is provided with the analytic applications:

M anual
Data Mart Reference

Contents

Reference details that describe the facts,
dimensions, and measures that comprise the
Primavera Data Mart, including information about
loading data from external sources.

Analytic Applications

Provides an overview of Primavera analytic
applications including Portfolio Management,
Business Intelligence, and Capacity Planning.
Also includes information on administering user
groups and rolesfor analytic applications and Data
Mart processing.

Portfolio Management

Provides conceptual and procedural information
about using Portfolio Management. Also includes
information on how Portfolio Management works
in the analytic applications environment.

Release Notes

Describes upgrade, resolved defects, and known
issues in Portfolio Management, Business
Intelligence, and Data Mart.

For optimal online image quality in Adobe Acrobat, Primavera
recommends setting the magnification to 200-250% when referring to

graphics in these files.
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Contacting Primavera
You can contact Primavera by mail, telephone, or the World Wide Web:

Primavera
150 Spear Street, 11th Floor
San Francisco, CA 94105

Telephone: (415) 229-3700
Fax: (415) 229-3999

World Wide Web: http://www.primavera.com/support /
ps_om_ev_supportprogram.html

Analytic Applications 11
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1. Overview

The analytic applications bring analytical processing capabilities to your
Primavera product environment. These applications provide your enterprise with
powerful planning, data analysis, and reporting tools to measure project portfolio
management (PPM) effectiveness.

This chapter provides an overview of the analytic applications. Topics include:

+ Featuresand Benefits

¢ System Architecture

+ Datalntegration

Fle  Edit  Wiew  Tools

BY Current View: Group By:

5 % % [ Dtaul Project Scorscard = | @ [Mane =l “ @ @ I:‘ Q
Include in _ ‘ ‘ 1 1 1
Summary Project Name Client File Edit View Data Chat Tools Help [

I B o e, = ¥ ?
All Current Projects ‘ ‘ pilpewn ~ 20 &L T B W (&)
Summary

I ExpenceReports Mac

12 &TA slleg

I rment Canads client

I Agra 22 Toor Client

2 bbbee Mac

I CAD-USD project DotCom

o == ARGON

2 Copy alleg

2 GTA alleg

I DProjectz003 CITROD

Figure 1-1  Analytic Applications
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1.1

Features and Benefits

The analytic applications include:

*

Portfolio Management (PM)

PM isastrategic planning application that allows service delivery
organizationsto align their funding decisions and profit planning with
corporate strategies and objectives. PM ensures that funding decisions are
controlled in a systematic manner. Refer to the Portfolio Management Guide
for more information.

Business Intelligence (BI)

Bl includes a set of predefined analytics (Budget vs. Actual, Resource
Utilization, Project and Pipeline Forecasts, etc.) for measuring the
performance of PPM processes.

Leveraging industry-standard analytical utilities such as drill up/down and
pivot tables, Bl provides decision makers with flexible tools to create and
capture multiple data views. Users can create their own custom analytics
without programming support.

Capacity Planning (CP).

Capacity planning isamethodology for accurately modeling resource supply
and project demand. It hel ps enterprise professional s assess current capacity

reguirements and predict future trends. Primavera provides both a CP report
and a CP analytic.

14 Analytic Applications



Overview

With the analytic applications:

+ A division manager can forecast upcoming staffing needs on a region-by-
region basis. The manager can also use analytics to balance resources across
upcoming projects based on metrics collected from completed projects.

+ Your enterprise financial support team can view Budget vs. Actual financial
information on a project-by-project basis to troubleshoot possible cost
overrunsin atimely manner, as well as viewing by task type to identify
process bottlenecks.

+  Project Managers can analyze KPIs from completed projects to help define
and improve performance goals for upcoming projects.

+ Saessupport teams can forecast potential revenue opportunities and provide
suggested resource commitments and project timeframes based on detailed
profit and margin scenarios.
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1.2 System Architecture

This section briefly describes the main components in the analytic applications
environment. For details on installing the analytic applications, refer to the

System Administrator Guide.

Portfolio Management

Business Intelligence

Capacity Planning
Access Control
Web browser: Interface
Single Sign-on

Server

Primavera Application

Op Apps

Analytic Apps
Service

Alphablox Service

_—

OLAP
Database

m———
D
Data
Mart

!

v
S
A Apps

Database
—

G
w

Alphablox
Database
‘d

Figure 1-2  System Architecture
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1.2.1 Databases

The analytic applications are supported by the following databases:

¢ Operational Applications Database. Thisis arelational database that
contains data used by the Primavera applications (demand management and
resource management).

+ |nformation stored in this database acts as the source for data that
appears in the analytic applications.

¢ This database may aso include the Primavera Delivery Database that
stores delivery data such as financial transactions.

+ DataMart. Thisisarelational database that contains expanded,
denormalized data derived from the Primavera application database. Data
are stored in a star schema and acts as a foundation for building OLAP data
cubes.

¢ OLAP Database. Thisisamultidimensiona database that residesin
Microsoft Analysis Services. It contains the multidimensional cubes used by
the PM and BI applications for rapid data retrieval. Cubes in this database
are created during ETL (Extraction, Transformation, and L oading)
processing.

+ Analytic Applications Database. Thisis arelational database that contains
configuration and user authentication information (roles, login ID, etc.) used
by the analytic applications. This database contains the portfolio and KPI
definitions, view definitions, and overridden values.

¢ Alphablox Database. Thisisarelational database that stores custom
analytics you create with BI.

For more information about these databases, refer to the System Administrator
Guide.
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1.2.2 Primavera Application Server

For analytic applications, the Primavera application server supports the following

services:

+ Analytic Applications service. This service runsthe PM and Bl applications,
including access control and Portfolio Management KPIs.

+ Alphablox service. Working in conjunction with the Primavera application
server, Alphablox provides interface elements necessary to display and
manipulate analytics data. Thisincludes pivot tables, charts, etc.

With the BEA WebL ogic Application Server as afoundation, the Analytics
Application service includes:

+ Web container with a presentation layer for processing the Java Server
Pages (JSPs), Servlets, and HTML/XML content that make up the
analytic applications interface.

+ EJB container with a business layer for processing analytics business
logic and a persistence layer for managing database interactions.

Usersinteract with the analytic applications using a supported browser served by
an 1S web server. Primavera supports both HTTP and HTTPS communications
between the web browser and the Primavera application server.

In addition to PM, Bl and CP, the analytic applications also include an Access
Control interface for setting security roles and creating user groups. For more
information, see“ User Authentication” on page 22.
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1.2.3 ETL Data Flow

The following diagram shows the ETL data flow for the analytic applications.

Primavera Portfolio Management
Applications Business Intelligence
Capacity Planning
Operational
Applications
OLAP

Databases Database ~

Replicated

Databases Data Mart T

1. Extract 2. Transform 3. Refresh
& Load OLAP Database

Figure 1-3  ETL Data Flow

Primavera recommends deploying a replication strategy for the operational
applications databases. You can use these replicas as the source for ETL
processing, Actuate reporting, and for backup purposes.

¢ Step 1: Extraction.

During extraction, the ETL processor takes data from a replica of the
Primavera operational applications database.

Extraction may cause some performance impact on the operational
applications database (as with a database backup operation), but there is
minimal impact on end users.
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During this step, users can access Primavera applications, including analytic
applications.

+  Because extraction operates on a database replica, no database tables are
locked and no database operations are disabled.

*  The extraction process does not interact with the OLAP database.

+  Step 2. Transformation and L oad
Extracted data are denormalized (broken down to the smallest units and
replicated as necessary) by the ETL processor and loaded into the relational

datamart database. An example of denormalized data would be annual costs
broken down into monthly, weekly, or even daily increments.

This step constitutes the mgjority of the processing time. There are no
performance impacts on applications, but the data mart server is very active.
Primavera recommends a dedicated data mart server for companies that
support alarge community of Primavera users.

During this step:
*  Users can access the Primavera applications, including analytic
applications.

+ Usersrunning reports or other data extractions directly against the data
mart database will not have access. The data mart database is locked
during data transformation and load.

+  Step 3: OLAP Database Refresh.

The ETL processor takes data from the data mart and updates the cubesin
the OLAP Database.

There is no performance impact on most Primavera applications (and some
impact on the analytic applications).
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During this step:

*

*

Users can access most Primavera applications.

If no new classifications have been added since the previous ETL run,
userswill be able to access the analytic applications. However, data that
appears in analytics reports will not reflect the latest information until
the cubes are completely updated.

If new classifications have been added since the previous ETL run,

users will not be able to access the analytic applications until the cubes
are completely updated.
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1.24 User Authentication

Mame: |Lh\le

User enabled: | Yes =

PM Contributor Remove

Pl Creator Remove

P Reviewer

Everyane

P Creator

A Test Pi Ouner
P

Charles Group

Project Analyst
Flate Analyst
Rlesource Analyst

Cancel I [ OK

Figure 1-4  Access Control Interface

The analytic applications include an Access Control interface that enables
administrators to set access policies for users and groups of users. Features
supported by this application include:

+ Importing users from the Primavera operational applications
+ Managing user groups

¢ Assigning accessroles

+ Disabling and reenabling user access

For more information on managing user access, see “ Access Control” on page
139.
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User access defined for the analytic applications is compatible with other
Primavera applications. Analytics users are authenticated by the Primavera
application server using single sign on capabilities.

User Login
(Single Sign-on)

Access Control
Interface

Operational .
Applications l\P/lOftf0| io I
Databases anagement

Business
Intelligence

Applications Dbase
- User Groups
™ - Roles

LDAP Directory

N
Analytic

Figure 1-5  User Authentication Flow

To authenticate users:

*

An administrator uses the Access Control interface to import users, set up
user groups, and assign security roles for the analytic applications. User
access information is stored in the analytic applications database.

Users are authenticated against the Primavera application server.

Authenticated users are then granted access to the analytic applications
based on the appropriate security roles stored in the analytic applications
database.
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1.3 Data Integration

In addition to data from Primavera applications, the analytic applications enable
you to import project time, expense, and budget data from external data sources
and incorporate this information into standard PM processes and Bl analytics.

For details on external data sources supported by Primavera, see the
Data Mart Reference document provided with the Primavera
documentation set.

1.3.1 Staging Tables

To enable dataimport, the analytic applications support the following staging

tables to hold data from an external source;

¢ External Timesheet Data. Used for loading data from a Time tracking
system.

¢ External Expense Sheet Data. Used for loading data from an Expense
tracking system.

+ Externa Budget Data. Used for loading data from Budgeting systems.

¢ External Transaction Actuals Data. Used to load data from Project
Accounting systems. Dataimported from thistable are used with the Budget
vs. Actual analytic.

To import external data, users must popul ate these tables with their external data
and then configure the Data Mart ETL processor to transform this data into the
OLAP database.
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1.3.2 Process Flow

This section provides a high-level overview of how data are imported from an

external source.

Replicated
Operational Applications DataMart
Databases
OLAP Datab
@ »
Externa S

Figure 1-6  Data Integration Flow

The user provides an external command interface to load data into one or
more of the staging tables shown above. Only datain these tables can be
imported into the analytic applications.

The user must load the correct Primavera object 1Ds (for example, IDs for
projects, resources, and task codes) required by the tables. If Primavera
connectors are used to populate the core database, these can be used to load
IDs from the external system into Primavera applications and then match
IDs based on that data.

The user then sets properties in the configuration file for Data Mart
processing to enable execution of the external command and specify the
external staging tablesto load.
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+ During processing, operational data are extracted from the replicated
database and loaded into the data mart database. Once |oaded, the process
callsthe external command interface (if enabled) to load data into the
designated external staging tables.

¢ When the external command is complete, the ETL transformation process
begins and the operational data and external data are transformed into Data
Mart star schema tables.

+  After transformation, the OL AP data cubes are updated. These cubes contain
the operational data and the data imported from the external data source.

1.3.3 Data Freshness and Sources

Because the analytic applications use data extracted by ETL processing, rather
than data in the operational applications databases, data freshness depends on
how often the process runs.

Typically, processing runs at frequent intervals to prevent data from being
misleading or out-of-date. However, there is atime and resource overhead to
running the process.

If you are concerned about performance or data freshness, you can change the
frequency of datatransfer. For details, see “ M odifying the Schedule” on page
184.

Depending on your enterprise business reguirements, you may choose to run the
ETL process once a day, once aweek, or even less frequently. You can also
configure the processto run full or incremental updates.
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2.

Business Intelligence

Business Intelligence is an interactive reporting and analysis tool that measures
the effectiveness of your business based on information captured by the core
application. Getting answers to questions about your business performance has
never been easier.

This chapter describes using Bl applications. This chapter includes:

*

*

*

*

About Business I ntelligence
Getting Started

Available Analytics

Creating Custom Analytics
Custom Analytics— An Example
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2.1 About Business Intelligence

Using the Primavera Data Mart as a foundation, Bl sources a multidimensional
OLAP database that is optimized for analysis and reporting.

Leveraging Microsoft Analysis Services technology and the Alphablox charting

and interface tools, Bl enables you to interact with analytical reports, analyzing

and viewing information in avariety of waysto aid decision making.

You can:

¢ Use predefined analytics that address many of your analysis requirements.

+ Sort, pivot, and drill into data for a detailed view.

+  Seemultiple views of data by adding or removing new dimensions or fields.

+ Filter data by selecting specific dimension members.

+ Immediately create new, custom analytics views. No programming is
required.

¢ Print resultsin online or hardcopy format.

All monetary values that appear in Bl analytic have been converted into a
single reporting currency. For more information, see “Changing
Company, Exchange Rate Table, and Currency” on page 188.

211 Multidimensional Modeling

Multidimensional modeling isadesign process used to arrange datainto aformat
commonly known as “cubes.” Data arranged in cubes optimizes data access and
query performance.

In abstract terms, each side of a multidimensional modeling cube corresponds to
adimension of data. However, unlike a physical cube, multidimensional
modeling supports an unlimited number of dimensions.

The business measurements (facts you want to analyze) correspond to the inside
of the cube. Each section or dlice of the data (that is, the building blocks that
make up the cube) correspond to a different view of the data.
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M easures

- Planned Revenue
- Planned Cost

- Planned Margin

S90.1N0So Yy

Figure 2-1  Business Intelligence as a Multidimensional Cube

For example, afinancial performance report on projects might use data on actual
revenue, costs, hours, and expenses and compare it to the project budget. Users
might want to use this report to help them more accurately budget their projects
for the next fiscal year or check to see which projects were more closely aligned
with the budget.

Users can evaluate the current mix of projects to see which ones are under or
over budget and determine the factors that contribute to the overrun. Users can
drill down further to seeif aparticular project or project management areais over
budget, or if the trend spans across an entire region, department, or project type.
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2.1.2 Summary of Available Analytics

To help analyze project data, Bl includes a set of predefined analytics you can
use to perform some of the most common, popular Bl tasks. You can use these
analytics“asis’ or make them a starting point for creating your own custom
analytics.

Analyticsincluded with Bl are:

*

Budget vs. Actuals. Compares actual revenue, costs, hours, and material
resources with budget amounts and displays the variance. Thisanaytic
contains data based on financial periods.

Capacity Planning. Displays project demand or resource supply capacity
over agiven time period (daily, monthly, or annually).

Pipeline Forecasts. Forecasts future revenue, cost, and margin over agiven
time period (daily, monthly, quarterly, or annually) for opportunities. This
analytic contains data based on calendar or financial periods.

Project Commitments. Shows commitments over a given period of time
(daily, monthly, quarterly, or annually) for upcoming projects. This analytic
shows committed hours, billable amount, and cost.

Project Expense. Displays expenses by project pool, expense type, or
organization unit. This analytic contains data based on calendar or financial
periods.

Project Financials. Displays financia attributes of a project, such as
planned and actual cost, headcount, material costs, expenses, and percentage
of work complete. You can select projects by pool, organization unit, and
project manager. This analytic contains summarized datawithout calendar or
financial periods.

Project Forecasts. Forecasts future revenue, cost, and margin over agiven
period of time (daily, monthly, quarterly, or annually) for projects. This
analytic contains data based on calendar or financial periods.
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Project Satus. Displays projects by status, percent complete, project
manager, and pool. This analytic contains summarized data without calendar
or financial periods.

Project Time Report. Displays hours, billable revenue, and costs over a
given period of time (daily, monthly, quarterly, or annually) for projects.
This analytic contains data based on calendar or financial periods.

Resource Summary. Summarizes planned vs. actual resources usage and
supporting financial details. You can select resources by name, pool,
organization unit, resource type, and manager. This analytic contains data
based on calendar or financial periods.

Resour ce Utilization. Displays details on planned vs. actua utilization of
resources. You can select resources by name, pool, organization unit,
resource type, and manager. This analytic contains data based on calendar or
financial periods.

Custom Analytic. Displays custom analytics defined for your enterprise.
See “ Creating Custom Analytics’ on page 79.
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2.2 Getting Started

2.21 Login

To open BI, enter its URL in asupported browser. This URL is case sensitive and
follows the format:

http:// [HOST] /BusinessIntelligence/BusinessIntelligence

where [HOST] isthe name of the computer where the analytic applications web
server resides. If your enterprise relies on Secure Socket Layer (SSL) encryption,
the protocol, or first part, of the URL must be HTTPS. For example:

https://[HOST] /BusinessIntelligence/BusinessIntelligence

A login page appears. Enter avalid username and password. Thisisthe same
username and password you use to login to the Primavera operational
applications.

When you launch Bl, it appears in a new window. You can close the original
window at any time after the Home page appears.

Roles assigned by the administrator for analytic applications determine which
analytics are available to you. Each role has a corresponding set of analytics you
can access. See “Bl Roles’ on page 144.
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2.2.2 The Bl Home Page

After login, the home page displays alist of analytics.

} Primavera Busi

Welcome to Primavera Business Intelligence

Custom Analytic
Displays custom analytics defined for your
enterprise

Project Financials

Displays financial attibutes of projects, such as
planned and actual cast, headeount, material
costs, expenses, and S work complete. You
can select projects by pool, arganization unit
and project manager.

Resource Summary
Displays planned and actual usage of
resaurces and supporing financial details. You (

can select resources by resource name,
resource pool, organization unit, resource type,
and resource manager.

Project Forecasts
Forecasts futute revenue, cost, and margin aver
a given time petiod (daily, monthly, quarterly, or

User Guide | Exit

Project Status
Displays projects by status, percent complete,
projectmanager, and pool

Resource Utilization

Displays actual utlization of resaurces. You can
select resources by resource name, resource
pool, organization unit, resource type and
fesource manager.

Budget vs. Actuals
Compares actual revenue, cost, hours, and
material resources with budgeted amounts and
displays the variance.

Pipeline Forecasts
Farecasts future revenue, cost, and margin over
a given time period (daily, monthly, quarterly, or

annually for projects

Preject Commitment

Forecasts future revenue, cast, and margin over
a given time period (dally, monthly, quarterty, or
annually) Tor project commitments

i) Sl < S) S

Project Expense (—
Displays project expense amount over a given

time perind (daily, monthly, or annually) for ! \
resources or for projects \

annually) for

Project Time Report

Displays hours, billable amount, cost amount
over a given time periad (daily, manthly, or
annually) for resaurces

Capacity Planning
Displays detailed information on project staffing
demands and resource supply over a given
period of time (daily, monthly, or annually)

—  Click to

view an
analytic.

Figure 2-2 Bl Home Page

Users who have privileges to access an analytic can open and view all aspects of
the analytic, but they cannot grant other users the privilegesto view the analytic.
Analytics that a user cannot access are dimmed on the home page.
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223 Understanding the Interface

To facilitate interactive spreadsheet modeling, database reporting, and data
visualization, the Bl interface includes a set of controls that enable you to
manipul ate data and perform analysis. Analysis actions such as drilling, pivoting,
sorting, and selecting are performed using grids and charts, tool bar buttons, and

menu options.

The following illustration shows controlsin the Bl window.

Edit Customn Analvtic | Exit

— Command

m @ | Jump to: I %
Project Financials =
File Edit View Data Chat Tools Help ff
= [ L . O ?

menus

L il s Bl a4 BORE

Tool bar

EABC Project Pool 3,743,932.80 2,374,
HAC Projects

1

652,912 80

058,285.20

F39,760.00
445,299 99
17032176
T71,464.40
oo
oo
068,800.00
oo

i}

df Margirly
369,439 60

Signed Resources

11.00
1.00;
8.00;

no;

10.00

4800

19.00
4.00;

0o;
4.00;
1.00;

3.00;

buttons for
viewing and
manipulating
analyticsdata.

— Datain grid

form

EICAD Project Pool 1,578,845.60 1,027,032.80
HForecasts Project Pool 3,6871,643.20 281335800 1
GG Project Pool 1,395,200.00  755,440.00

5,000,000

5,000,000

4,000,000 —

3,000,000

2,000,000

1,000,000 - I | l

o= T
Planned Revenue  Planned Cost Planned Margin ~ Assigned Resources
Measures

™ Forecasts Project Paol W GG Project Pool  GG_BI Project Pool
® SK_PartTime Project Pool W TK Project Pool  Tony Project Pool

Datainchart
form

Figure 2-3  BI Controls

34 Analytic Applications



Business Intelligence

2.2.4

Tool Bar Buttons

Button

®

Description

Home. Click to return to the Bl home page. The home page
contains linksto Bl analytics.

Alternatively, you can use the Jump to drop down to open an
analytic:

Jump to:

I Fipeline Forecasts = I

@

Save As Custom. To create a custom analytic, use Bl controlsto
create a custom view, then click this button to save your
changes. A custom analytic can be viewed by anyone who has
access to the baseline analytic you used as a starting point to
create the custom analytic.

|

Popout. Click to view the analytic in a separate window.

Copy. Click to copy datafrom selected cellsin agrid.

Undo

Undo.Click to successively undo changes you have made to an
analytic. Alternatively, you can select the specific action you
want to undo from the Undo drop down.

Undo -

Unda
Expand ABC Project Pool
Expand Z= Toor Project Pool

Redo

Redo.Click to successively restore your changes. Alternatively,
select the specific action you want to restore from the Redo drop
down.

Redo -

Redao

Expand July
Move Measures on Column axis
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Button

Description

Export to Excel. Available for both grid and chart view. Starts
Microsoft Excel and displays the selected data in spreadsheet
format. You can then save this data as an Excdl file.

Export to PDF. Saves the datain PDF format.

? ?. Opens Bl documentation.

Exit Exit. Closes the Bl application.

E Grid View. Displaysthe datain grid (tabular) form.

A Chart View. Displays the data in chart form. Use the Chart

menu to select one of the following basic chart types:
3D Bar Chart

Vertical Bar Chart

Vertical Line Chart

Pie Chart

Choose Chart » Types » More... to select additional chart
types, including Radar Chart, Waterfall Chart, Pareto
Chart, and Dial Chart.

&l

Page View. Displays a simple, non-layout view of the page.

Layout View. Displays alayout pane for the analytic. Use this
view to control the presentation and placement of dimensionsin
an analytic. See “ Changing Data L ayouts’ on page 80.

The View buttons listed above act as toggles. Click to turn on or off a
particular view. The View buttons are not mutually exclusive. For example,
you can select both the Grid View and Chart View to display an analytic that
includes a grid and a chart.
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The following controls apply to rows and columns you have selected in a grid.

Button

Drill Down

Description

Drill Down. By default, Drill Down displays the next-lowest
level of datain the hierarchy. For example, if data associated
with all Business Rolesis selected, Drill Down displays data
associated with each separate Business Role.

You can also use Data Options to control drill down behavior.
For more information, see “ Setting Data Options’ on page
9.

Drill Up

Drill Up. Displays the next-highest level of datain the
hierarchy. For example, if data associated with an individual
project is selected, Drill Up displays consolidated data for all
projectsin the pool.

=

Member Filter. Displays the Member Filter page. Use the
Member Filter to select which dimension members you want to
view. You can add, remove, change, and preview every
dimension member in your dataset. See“ Filtering Members’
on page 83.

ZjMember Filter — Web Page Dialog x|

Selected Members
ABC Project Pacl =

Alfa project

'L._E Completed Projsct

Delivery Project for Satelite
Delivery_Project

m Delivery_Project |
Fir

Hagie
Mars

<< Remove All Nissan

O-lala
Ping Png

—Dimension Hierarchy

[Z All Projects

i -l
Find [ Moveup |[ Mave Down
[ ok ][ cancel |[ Apply |[ Heln
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2.2.5

Menu Commands

This section describes menu commands you can use to manipul ate analytics.
Some menu commands duplicate functions on the tool bar.

File and Edit Menus

Menu Command Description
File Export to PDF Use commands on the File menu to

Export to Excel export the analytic to PDF or Excel
format.

Edit Undo Use commands on the Edit menu to

Redo undo or redo changes to your

_ analytic. Select History to choose

History from alist of previous command to
undo.

Copy Click to copy data from selected
cellsinagrid and paste it into other
applications.

Delete Click to hide one or more selected
dimensions.

Find Enables you to search for members
or dataon agrid. Search results are
highlighted and (if necessary) the
display scrolls to show the resullt.
You can use ? (single character) and
* (one or more characters)
wildcardsin the search.

Select All Click to select dl cellsin agrid.
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View Menu
Menu Command Description
View Toolbar » Use Sandard, Navigation and
Customize to show, hide, or
customize toolbars.
Grid Use these commands to show or
hide the grid, chart, page, data
Chart .
layout, or popout versions of the
Page Filter analytic.
Data L ayout
Popped out
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Data Menu

Menu

Data

Command
Sort

Description

Sorts datain ascending or descending
order. Optionally, you can preserve the
member hierarchy when you sort.

Expand

Expands the dimension hierarchy to
display the next level of detail.

Collapse

Closes the current hierarchy level and
returns you to the parent dimension.

Drill Up
Drill Down

See“Tool Bar Buttons’ on page 35.

Use the Options command on the Data
Menu to set thedrill level. You can drill to
all descendents, leaf members, siblings,
etc.

Expand All

Expands the dimension hierarchy to show
al levels of detail.

Pivot

On agrid, this command moves a
dimension heading from the row axisto
the column axis or vice versa. This action
works only on a single dimension you
have selected.

Show Only

Displays only the dimensions you have
selected.

Note: Show and Hide options are
disabled by default. Use Data » Options
to enable them.

Hide

Hides the selected dimensions from view.
Use the Unhide All command to

redisplay.
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Menu

Data,
cont.

Command Description
Unhide All Displays all dimensions in the analytic.
Advanced » Shows all lowest-level dimension
Show Bottom members regardless of grouping.
Level
Advanced » Shows all members of adimension at the
Show Siblings same hierarchy level.
Advanced » Enables you to select which membersin
Set Hidden rows or columnsto hide.
Advanced » Enables you to create and apply format
Format Mask masks to:
- selected cellsin agrid
- data displayed in charts
For example, you can apply format masks
to display datain Thousands (K) or to
show negative valuesin red.
For more information, see See “Using
Format Masks’” on page 96.
Advanced » Opensthe Merged Headers page. You can

Merged Headers

use this page to combine two data
dimensionsinto one.
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Menu

Data,
cont.

Command

Advanced »
Traffic Lights

Description

Enables you to set custom warning
signals (called traffic lights) for out-of-
scope results. You can set traffic lights for
rows, columns, or selected cells of data.
For moreinformation, see “ Traffic
Lights’ on page 89.

Swap Axes

On agrid, thiscommand moves al
dimension headings on the row axisto the
column axis and all dimension headings
on the column axis to the row axis.

Member Filter

Opens the Member Filter page. See
“Filtering Members’ on page 83.

Options

Use this command to set data options
including Drill Down behavior and
suppressing zero rows and columns. See
“ Setting Data Options’ on page 94.
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Chart Menu
Menu Command Description
Chart Types Sets the type of chart that appears when

you select the Chart view. Basic chart
typesinclude Bar, 3D Bar, Line, and Pie.
Choose Chart » Types» More...to
select additional chart types.

Axis Placement

Enables you to set where dimensions
appear on the chart.

Data Lists dataincluded in the chart.

Configuration

Selected Data Chartsthe cells, rows or columns you

Only have selected in agrid.

Options Sets chart options such as chart title,
legend location, label orientation, and
groupings for small values.

Trendlines Adds atrendline to your chart. Trendlines

enable you to leverage existing data
patterns and extrapolate future results.

To help you accurately match data values
displayed in achart, trendline choices
include:

Linear

Polynomial (up to 4th order)
Exponential

Power

Logarithmic

Moving Average
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Tools Menu
Menu Command Description
Tools Grid Options Sets grid line configuration, row

indentation, etc.

Present Options

Sets chart and grid alignment (vertical or
horizontal) and display order (chart first
or grid first).

Manage » Traffic
Lights

Setsthe order of how traffic lights are
applied. Also lets you edit or remove
traffic lights. For more information, see
“Traffic Lights’ on page 89.

Manage »
Format Masks

Sets the order of how format masks are
applied. Also lets you edit or remove
format masks. For more information, see
“Using Format Masks’ on page 96.
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2.3 Available Analytics

This section includes areference description of each predefined analytic included
with BI. It provides:

*

*

*

*

*

*

*

Sampleillustration

Summary description of the analytic

List of user roles that can access the analytic
Description of theinitial, default view

Notes (if any) about data presented in the analytic
Dimensions included in the analytic

Measures provided by the analytic

For a detailed description of OLAP Database dimensions, see the
Primavera Data Mart Reference included with the Primavera product
documentation.

This section describes the following analytics:

*

*

*

*

Budget vs. Actuals
Capacity Planning
Pipeline Forecasts
Project Commitments
Project Expense
Project Forecasts
Project Financials
Project Status
Project Time Report
Resource Summary
Resour ce Utilization
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2.3.1 Budget vs. Actuals

Material Cost

_-
n Type | Calculated Budoet Amount  [Variance Amountl Calculated Budget Amount  [Variance »«muun
EIGross Margin 70,400.00 70,400.00 70,400.00 70,400.00
ETotal Revenue 195,320.00 195,320.00 195,320.00 195,320.00
ELabor Revenue 188,320.00 188,320.00 188,320.00 188,320.00
Labar Time Revenue 188,320.00 188,320.00 188,320.00 188,320.00
Fined Schedule Revenue
EExpense Revenue 7,000.00 7,000.00 7,000.00 7,000.00
Material Revenue Financial
Eatal Cost 124,920.00 12432000 124,920 Perod Sep 2003 =] Measures [Budget Amount -
ElLabor Cost 117,920.00 117,820.00 117,920
Labar Time Cost 117,920.00 117,820.00 117,920
Fined Schedule Cost
EExpense Cost 7,000.00 7,000.00 7,000

Figure 2-4  Budget vs. Actuals Analytic

Description

Compares actual revenue, cost, hours, and material resources with budgeted

amounts and displays the difference.

Accessible by users with the following Bl roles: Project Analyst, Resource

Analyst, Rate Analyst, Administrator.
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Initial View

Displays a summarized view of all projectsfor the current year and current three
financial periodsfor the current year.

Item Description
Row Dimension Gross Margin

Total Revenue (Labor Revenue, Expense
Revenue, Material Revenue)

Total Cost (Labor Cost, Expense Cost, Material

Cost)
Column Dimension Current three fiscal periods
Measures Calculated Budget Amount, Posted Amount,
Calculated Variance Amount
Page Not applicable
Filter Not applicable
Notes

¢ Only the committed budget data are displayed.

¢+ Thesummary data can be calculated only if the financia periods of all the
projects are the same. The user must ensure data are entered correctly.
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Dimensions

Budget Transaction Type. Examples: Labor, Expense, Material.
Financial Period. Examples: June_2003, July_2003.

Task Code (By Company). Examples: Coding, Pre-Sales, Testing, Strategy.

Org Unit (By Name)
Position (By Team)

Project (By Pool and By Client)

Resource (By Pool)

Measures

Measure
Calculated Budget Amount

Description

Calculated budget amounts are defined to the
project or resource level for:

- Revenue (Labor, Expense, Material)
- Costs (Labor, Expense, Material)

Labor revenue and cost amounts are based on
Committed hours

Allocated Budget Amount

High-level summary budget for:
- Revenue (Labor, Expense, Material)
- Costs (Labor, Expense, Material)

Labor revenue and cost amounts are based on
Committed hours
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Measure

Allocated Detail Budget
Amount

Description

Summary budget (broken down by period) for:
- Revenue (Labor, Expense, Material)

- Costs (Labor, Expense, Material)

L abor revenue and cost amounts are based on
Committed hours

Unposted Amount

Total amount approved for the following:
Revenue (L abor, Expense, Material)
Costs (Labor, Expense, Material)

L abor revenue and labor cost amounts are
based on Approved hours.

These amounts do not include budget
adjustments.

Posted Amount

Total amount approved for the following:
Revenue (L abor, Expense, Material)
Costs (Labor, Expense, Material)

L abor revenue and labor cost amounts are
based on Approved hours.

These amounts include budget adjustments.
Adjusted entries are necessary to update
accounts for items that are not recorded in
daily transactions.
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Measure

Variance

Description

Shows the difference between budget and
actual amounts. Variances measured include:

Calculated Variance. Showsthe difference
between the Cal culated Budget and the Posted
Amounts.

Allocated Budget Variance. Shows the
difference between the Allocated Budget and
the Posted Amounts.

Allocated Detail Budget Variance. Showsthe
difference between the Allocated Detailed
Budget and the Posted Amounts.

Units

Number of accounting and financial control
units associated with an budget or actual.
Budget units are a collection of expenditure
and revenue accounts necessary to fund a
certain organization unit, division, or set of
programs.

Unit measures are available for al budget and
actual categories.
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2.3.2 Capacity Planning

I T | CiTime (By Calendar] =
Resource (By Poa)) | Tatal Supply | U ply | Unus: y | Total 5u5 i Vet
EI66 Resource Poal|  3,024.00 00 302400 1,168

Bond, James 1,512.00 00 1,512.00 524
White, Lora 1,512.00 0o 1,512.00 524

L Resource Pool | 72,624.00 5,464.06 5264794 30365 | gy
Alexis, Chris A 1,512.00 21601 1,205.99 584
Aoy, Wil A 1,512.00 00 1,512.00 524
T R 1,512.00 756.00 756.00 524
EEET 1,512.00 21601 1,205.99 584 1 500
T 1,512.00 21601 1,205.99 524
e 1,512.00 904.00 602.00 524

b 1,512.00 21601 1,205.99 524
ST, GEIE) 1,512.00 756.00 756.00 554 1 1,000
Blue, Sharan

500

T
Unusable Supgly
Usable Supply

T
Total Supply

Figure 2-5  Capacity Planning Analytic

Description

Displays project demand or resource supply capacity over agiven time period
(daily, monthly, or annually).

Accessible by users with the following BI roles: Forecast Analyst, Administrator

For more information on capacity planning and some examples of using
the Capacity Planning analytic, see “Capacity Planning” on page 113.
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Initial View

A summarized view of resource utilization for the next three calendar months.

Item Description
Row Dimension Project (By Pool)
Column Dimension Next three calendar months
Measures Demand (Total, Filled, Fillable, Unfillable)
Supply (Total, Used, Usable, Unusable)
Page Not applicable
Filter Not applicable
Dimensions
Project (By Pool)

Project Pool (By Name)

Opportunity Pool (By Name)

Resource (by Pool)

Resource Pool (By Name)

Client (by Pool)

Client Pool (by Name)

Time (Calendar or Fiscal)

Org Unit (By Name)

Job Title. Examples: Consultant, Analyst, Tech Support, UNIX Admin
Financial Period. Examples: 2004-01, 2004-02, 2004-03

Business Roles. Examples: Manager » QA Manager, Engineering » QA
Engineer.
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Measures
Measure Description
Total Demand Total position hours for projects.
Filled Demand Position hours that have resources assigned.
Fillable Demand Position hours that can be filled with eligible

resources (based on the resource/project matching
model defined for your site), but do not have
resources assigned, yet.

Unfillable Demand

Demand Surplus. Position hours that cannot be
filled with eligible resources. Total Demand -
Filled Demand - Fillable Demand = Unfillable
Demand.

Total Supply All available resource hours

Used Supply Resource hours assigned to projects

Usable Supply Resource hours that could be assigned to projects
(based on the resource/project matching model
defined for your site), but are not assigned to
projects, yet.

Unusable Supply Supply Surplus. Resource hours that cannot be

assigned to projects. Total Supply - Used Supply -
Usable Supply = Unusable Supply.
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233 Pipeline Forecasts

Oppartunity By Paol) Measures  [=September|=October=Navember]
Win Confidence 00% .00% 00%
_ Forecast Rewenue  17,600.001%,400.00 16,000.00
E66_Bl Opportunity Poal -t Cost 5,280.00 552000  4,800.00
Frofit Margin % 70.00% L e |
Win Canfidence 00% R e,
Sliva_ Gitron Faorecast Rewenue  17,600.001:
s Faorecast Cost 5,280.00
Profit Margin % 70.00% 20000~
175004
15000
12500
10000
7500
s000
2500 e
T T T T
WinConfiderce  Forecast Revene Forecast Cost otk Margin %
Measures
Figure 2-6  Pipeline Forecasts Analytic

Description

Displays future revenue, cost, and margin over a given time period (daily,
monthly, quarterly, or annually) for opportunities.

Accessible by users with the following BI roles: Forecast Analyst, Administrator.
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Initial View

A summarized view of all opportunities for the next three calendar months.

Item Description

Row Dimension Opportunity (By Pool)

Column Dimension Next three calendar months

Measures Win Confidence, Forecast Revenue, Forecast

Cogt, Profit Margin %

Page Not applicable
Filter Not applicable
Dimensions

Opportunity (By Pool)

Time (Calendar or Fiscal)

Opportunity Pool (By Name)

Opportunity Status. Examples: Closed, Open.

Org Unit (By Name)

Final Outcome. Examples: Won, Lost, Undecided, Did Not Pursue.
Engagement Type. Examples: Business Value Proposition, Market Opportunity.
Forecast Flag (Included in Forecast, Not Included in Forecast)

Client (By Pool)
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Measures

Measure

Win Confidence

Description

Confidence factor entered for the opportunity asa
percent value. The win confidence factor is taken
into account as a weighting against revenue and
cost

Forecast Revenue

This calculation is based on the forecast hours and
rates for the opportunity and win confidence

Forecast Cost This calculation is based on the forecast hours and
rates for the opportunity and win confidence
Profit Margin Forecast Revenue - Forecast Cost = Profit Margin.

Profit Margin % = Profit Margin as a percentage
of Forecast Revenue.
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2.3.4 Project Commitments

September
-ornmitted|Billable AmountCo
[ECAD Project Pool 352.00 44,000.00 3220200 362.00 46,000.00
EForecasts Project Pool TREE
GG Project Pool Calenday) | September =
G_Bl Project Pool 1,056.00 63,360.00  31,680.00
Project Pool 1,408.00 244,498.20 164,419.20
K_ Project Pool
K_Flex Project Pool
ESK_PartTime Project Pool
4 250,000 —
225,000
200,000
175,000
150,000
125,000
100,000
75,000 o
50,000
25,000
—
o T T
Hours Committed Billsble Amount  Cast Amourt
Measures
+ ABCProjectPool = ACProjects
= CADProjectPool = Forecasts Project Pool
s GG Project Pool + GG_BI Project Pool
Figure 2-7  Project Commitments Analytic

Description

Displays commitments over a given period of time for upcoming projects.

Accessible by users with the following Bl roles: Rate Analyst, Administrator.
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Initial View

A summarized view of all projects for the next three calendar months.

Item Description
Row Dimension Project (By Pool)
Column Dimension Next three calendar months
Measures Hours Committed, Billable Amount, Cost Amount
Page Not applicable
Filter Not applicable
Dimensions

Project (By Pool)
Time (Calendar or Fiscal)

Business Role. Examples: Manager » QA Manager, Engineering » QA
Engineer.

Commitment Type. Examples: Assigned, Change Requested, Reserved,
Suggested.

Org Unit (By Name)

Position (By Project)

Project Type. Examples. High Priority, Medium Priority, Low Priority.
Resource (By Pool or Org Manager)

Project (By State). Examples: Candidate, Delivery, Pursuit, Scenario.
Project (By Status). Examples. Active, Complete, Prospective.

Project (By Client)

Project (By Org Manager)
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Client (By Pool)
Opportunity (By Pool)

Measures
Measure Description
Hours Committed The committed hours for this position/resource.
Billable Amount This calculation is based on the committed hours
and rates for the project and position.
Cost Amount This calculation is based on the committed hours
and rates for the project and position.
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235 Project Expense

Description
Displays project expenses by project pool, expense type, or organization unit.

Accessible by users with the following Bl roles: Project Analyst, Resource
Analyst, Rate Analyst, Administrator.

Initial View

A summarized view of all projects for the previous three calendar months.

Item Description
Row Dimension Resource (By Pool)
Column Dimension Previous three calendar months
Measures Expense amount
Page Not applicable
Filter Approved Expense
Notes

This report only shows the amount of the expense attributable to the resource. It
does not show the amount reimbursable to the resource. Therefore, expenses paid
by the company for aresource will be added in the Resource Amount measure of
this report.
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Dimensions
Resource (By Pool)

Time Expense Status. Examples: Approved, Non Approved (not reimbursed),

Submitted.

Time (Calendar and Fiscal). Based on date the expense was reported.

Expense Types. Examples: Mileage, Airfare, Lodging.

Project (By Pool)

Task Code (By Company). Examples. Coding, Pre-Sales, Strategy, Maintenance.
Billable. Examples: Billable, Non Billable.

Org Unit (By Name). For non-project type expenses.

Measures

Measure Description

Expense Amount Expense amount as entered by the resource.

Resource Amount Amount reimbursed to the resource (includes
expenses paid by the company for aresource). For
details, see “Notes’ above.

Expense Unit Number of units of the expense. This appliesto
mileage and similar types of expenses. The
aggregation of this measurement across a variety
of expenses may not be meaningful to analytic
users.
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2.3.6 Project Forecasts
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Figure 2-8  Project Forecasts Analytic

Description

Forecasts future revenue, cost, and margin over a given period of time for
projects.

Accessible by users with the following BI roles: Forecast Analyst, Administrator.
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Initial View

A summarized view of all projects for the next three calendar months.

Item

Row Dimension

Description
Project (By Pool)

Column Dimension

Next three calendar months

Measures Committed Hours, Potential Hours, Utilization %
Page Not applicable
Filter Not applicable

Dimensions

Project (By Pool)

Time (Caendar or Fiscal)

Business Roles. Examples: Manager » QA Manager, Engineering » QA

Engineer.

Position (By Project)

Project Type. Examples. High Priority, Medium Priority, Low Priority.

Commitment Type. Examples: Assigned, Change Requested, Excluded.

Project (By State). Examples. Candidate, Delivery, Pursuit. Scenario.

Project (By Status). Examples: Active, Complete, Prospective.

Org Unit (By Name)
Client (By Pool)

Opportunity (By Pool)
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Measures
Measure Description
Committed Hours Committed hours for the project.
Potential Hours Potential hours for the project.
Utilization Potential Hours - Committed Hours = Utilization.
Utilization % = Utilization as a percentage of
Potential Hours.
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2.3.7

Project Financials
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Figure 2-9

Project Financials Analytic

Description

Displays financial attributes of a project, such as planned and actual cost,
headcount, material costs, expenses, and percentage of work complete.

Accessible by users with the following Bl roles: Project Analyst, Administrator.
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Initial View
A summarized view of all active projects grouped by project pool.

Item Description
Row Dimension Project (By Pool)
Column Dimension All active projects
Measures Planned Revenue, Planned Cost, Planned Margin,
Assigned Resources
Page Not applicable
Filter Not applicable
Notes

This analytic contains summarized data without calendar or financial periods.

Dimensions

Project (By Pool)

Project Status. Examples: Active, Complete, Prospective.

Org Unit (By Name)

Billable. Examples: Billable, Non Billable.

Project (By Org Manager or Client)

Project Pool (By Name or Leaf Level)

Project Type. Examples. High Priority, Medium Priority, Low Priority.
Project State. Examples: Candidate, Delivery, Pursuit. Scenario.
Client (By Poal)

Opportunity (By Pool)
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Measures

Measure Description

Planned Revenue This calculation is based on the planned hours for
the project. (project hours x bill rates)

Planned Cost This calculation is based on the planned hours for
the project. [(project hours x cost rates) + material
resource cost]

Planned Margin Planned Revenue - Planned Cost = Planned
Margin

Assigned Resources Count of named resources assigned to the project
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2.3.8 Project Status
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Figure 2-10 Project Status Analytic

Description

Displays projects by status, percentage complete, project organization unit
manager, locations, and pool.

Accessible by users with the following BI roles: Project Analyst, Administrator.

68 Analytic Applications



Business Intelligence

Initial View

A view of al active project pools.

Item

Row Dimension

Description
Project (By Pool)

Column Dimension

All active projects

Measures Percent Complete, Assigned Hours, Unstaffed
Hours, Planned Revenue, Planned Cost, Planned
Margin, Assigned Resources
Page Not applicable
Filter Not applicable
Notes

Rates are based on the value defined for the position’s rates. If the position rate
has been set to use Resour ce Rates and no resource has been assigned, then the
rate is not considered. Therefore the position will have zero planned and cost

amounts.

Dimensions
Project (By Pool)

Project Status. Examples: Active, Complete, Prospective.

Org Unit (By Name)

Billable. Billable, Non-Billable

Project (By Org Manager or By Client)
Project Pool (By Name or Leaf Level)

Project Type. Examples: High Priority, Medium Priority, Low Priority.

Project State. Examples: Candidate, Delivery, Pursuit. Scenario.
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Client (By Pool)

Opportunity (By Pool)

Measures
M easure Description
Percent Complete Elapsed time/Total duration of the project.
Assigned Hours Sum of project hours for which a named resource

isassigned to a position.

Unstaffed Hours

Total planned project hours - total hours assigned -
total hours reserved for the position = unstaffed
hours.

Planned Revenue

This calculation is based on the committed hours
for the project and position. (project hours x bill
rates)

Planned Cost This calculation is based on the committed hours
for the project and position. [(project hours x cost
rates) + material resource cost]

Planned Margin Planned Revenue - Planned Cost = Planned

Margin.

Assigned Resources

Count of named resources assigned to the project.
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2.3.9 Project Time Report

Description

Displays hours, billable revenue, and costs for projects.

Accessible by users with the following Bl roles: Project Analyst, Resource
Anayst, Rate Analyst, Administrator.

Initial View

A summarized view of all projects for the previous three calendar months.

Item Description
Row Dimension Resource (By Pool)
Column Dimension Current and previous two calendar months
Measures Hours, Billable Amount, Cost Amount
Page Not applicable
Filter Approved Time

Dimensions

Resource (By Pool)

Time Expense Status. Examples: Approved, Disapproved, Submitted.
Time (Calendar or Fiscal)

Billable. Examples: Billable, Non Billable.

Position (By Project)

Project (By Pool)

Business Role. Examples: Manager » QA Manager, Engineering » QA
Engineer.
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Task Code (By Company). Examples: Coding, Pre-Sales, Strategy, Maintenance
Org Unit (By Name). For non-project time categories.

Measures

M easure Description

Hours The hours entered for the position by resources
under various states.

Billable Amount This calculation is based on hours entered for the
project and position (unposted amounts).

Cost Amount This calculation is based on hours entered for the
project and position (unposted amounts).
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2.3.10 Resource Summary
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Figure 2-11  Resource Summary Analytic

Description

Summarizes planned and actual utilization of resources and supporting financial
details. You can select resources by resource name, resource pool, organization
unit, resource type, and manager.

Accessible by users with the following Bl roles: Resource Analyst, Rate Analyst,
Administrator.
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Initial View

A summarized view of resource usage and supporting financial details for the
next three calendar months.

Item Description
Row Dimension Resource (By Pool)
Column Dimension Next three calendar months
Measures Planned Revenue, Planned Cost, Unposted L abor
Revenue, Unposted Labor Cost
Page Not applicable
Filter Not applicable
Dimensions
Resource (By Pool)
Time (Calendar or Fiscal)

Resource Type (By Company). Examples: Agency Resource, Hourly, Salaried,
Hardware, Supplies.

Org Unit (By Name)
Resource (By Org Manager)
Resource Pool (By Name)
Resource Pool (Leaf Level)
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Measures

Measure

Planned Revenue

Description

This calculation is based on the committed hours
for the resource. Committed hours include
shortlisted, reserved, assigned, and excluded
hours.

Planned Cost This calculation is based on the committed hours
for the resource.

Unposted L abor This calculation is based on revenue from

Revenue approved hours for the resource (prior to
adjustments).

Unposted Labor Cost This calculation is based on the cost of approved

hours for the resource (prior to adjustments).
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2.3.11 Resource Utilization
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Figure 2-12 Resource Utilization Analytic

Description

Displays details about planned and actual utilization of resources. You can select
resources by resource name, resource pool, organization unit, resource type, and
resource organization unit manager.

Accessible by users with the following Bl roles: Rate Analyst, Administrator.
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Initial View

A summarized view of resource utilization for the next three calendar months.

Item

Row Dimension

Description

Resource (By Pool)

Column Dimension

Next three calendar months.

Measures Committed Hours, Approved Hours, Planned
Utilization, Actua Utilization.
Page Not applicable.
Filter Not applicable.
Dimensions
Resource (By Pool)

Time (Calendar or Fiscal)

Resource Type (By Company). Examples: Agency Resource, Hourly, Salaried,

Hardware, Supplies.
Org Unit (By Name)

Business Roles. Examples: Manager » QA Manager, Engineering » QA

Engineer.

Resource (By Org Manager)

Resource Pool (Name or Leaf Level)
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Measures

Measure

Committed Hours

Description

The committed hours entered for this resource.

Approved Hours

The approved hours entered for this resource.

Planned Utilization

Based on committed hours for this resource
calculated as a percentage of available hours.

Actua Utilization

Based on approved hours for this resource
calculated as a percentage of available hours.
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24 Creating Custom Analytics

This section describes some of the common tasks you might perform to create
your own custom analytics. The general procedure for creating custom analytics
includes:

+ Changing Data Layouts
¢ Filtering Members

¢ TrafficLights

¢ Setting Data Options

¢+ Using Format Masks

¢ Saving Your Changes

Each of these tasks is described bel ow. For a start-to-finish example of creating a
custom analytic, see “ Custom Analytics—An Example” on page 106.

Data shown in the following illustrations is only an example. Data that
appears in your enterprise analytics will be different.

When you change an analytic by filtering members, adding traffic lights,
format masks, and so on, make sure you save your changes as a custom
analytic. Otherwise, these changes will be lost when you exit and restart
BI.

XN ]
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241 Changing Data Layouts

To change the data layout:
1. Openananalytic.

You can select an analytic from the Jump to drop down or click an analytic
on the Bl home page.

2. Sdlect View » DatalLayout or click on the tool bar.
A layout pane appears.

Layout
h EHDW TERIT: v Pool)
pane with a HABC Resource Pool
I |$ Of I Resource [By Pool) = I MAC Resources
. : HCAD Resource Pool
dl mensions [F m] (3 HDeci Resources .
availablefor Time By Calonda] = Foref:asts Resource Pool .00
. HFullTime Resources .00
the anal ytl C I Measures :l' [EGG Resource Pool .00
| E P HGG_BI Ali Resource Pool 20160.00
Row =L [©6G_BI Resource Pool 53,760.00
! L Resource Pool 11,625.60
Col umn, L [ other EPartTime Resources .00
e and [HSK_ Resource Pool 179,760.00
I ag l | Resource Type (By Company] - | [ZSK_Flex Resource Pool .ao
Other Trg Unit By Name] =] ESK_PartTime Resource Pool .00
. B Fol HTK Resource Pool .00
Categorl €s usness noes = [HTony Resource Pool .00
|F|esourc:e [By Org Manager];l Elink
| Resaurce Pool (By Name) »|  |=WWeekend Resources .an
| Resource Pool [Leaf Level) ~|  [EWWonder Resources 0o
I Time [By Fiscal Year] = I [HZ Resource Pool .00
HZZ CP Resource Pool .00
[:ZZ Sharan Resource Pool .00
HZZ Toor Resource Pool .00
]
Figure 2-13 Data Layout Pane
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Use this pane to specify which dimensions appear in the analytic:

+ Dimensions listed under the Row category appear asrowsin the
analytic.

+ Dimensions listed under the Column category appear as columnsin the
analytic.

¢ The Other category acts as a holding area. Dimensionslisted in this

category are available for use, but do not appear in the grid or chart. To
view these dimensions, move them to rows and columns as desired.

+ Dimensions listed under the Page category provide afilter for data that
appearsin grids and charts. For more information, see “ Using the Page
AXis’ on page 87.

Each dimension in the layout pane includes a drop down with commands

that control the layout.

Click to display layout
commands for the
dimension.

Reszaurce Type [By Campary] ;I
Rezource Type [By Compary)

b ove down

W ove bo row axis
tove to column axis
Move to page axiz
kember Filter...

Commands on this drop down vary depending on whether the dimension |E
is currently located in the row, column, or other category.
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3. Select adimension and change the layout position as desired. Changes you

can make include:

Command

Move to row axis

Action

Adds the dimension to the row axis

Move to column axis

Adds the dimension to the column axis

Move to page axis

Adds the dimension to the page axis.

Move to Other

Removes a dimension from the row or column
axisand placesit in the Other category.

Move down/up

Use these commands to reorder dimensionswithin
a category. Thisimpacts the dimension hierarchy
that appearsin rows and columns. For example, if
Org Unit is placed above Time (By Fiscal Year) in
the Row category, Org Unit acts as the primary
sorting key for the rows and the appropriate Fiscal
Years are listed within each Org Unit.

Member filter

Opens the Member Filter page. Use this page to
select which members appear in adimension. See
“Filtering Members’ on page 83.

4. When you have finished making layout changes, click to return to Page

View.
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2.4.2 Filtering Members

You can use the Member Filter to select the dimension members you want to
view in an analytic. You can add, remove, change, and preview every dimension
member in your data set. For example, you could change the Time dimension to
display data for the entire Year 2003, instead of afew months.

You can add dimension members individually or according to their relationship
to each other. You can also select members to remove or reorder, search for
members to add, and then preview your selections before returning to the
analytic.

To filter members:
1. Openananalytic.

You can select an analytic from the Jump to drop down or click an analytic
on the Bl home page.

2. Select the dimension with members you want to filter. You can use either the
grid or chart display to select adimension.

3. Sdect Data » Member Filter or click IEE on the tool bar.

You can also display the Member Filter by selecting a dimension in the
Layout View and selecting Member Filter from the dimension drop down.
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The Member Filter page appears. The left side of the page shows a hierarchy
of al possible dimension members. The right side shows members that are

currently displayed in the analytic.

August

Resource (By Poal) Flanned RevenuelPlanned CostActual RevenuelActual Costiflanned RevenuelP!

available members. To include
amember inthe analytic, select
the member and click Add.

EABC Resource Paol 00 oo : 3 : Select the
EAC Resources .on g .on .on .on . .
EICAD Resource Pool 42,000.00  30,744.00 00 00 44,000.00 dimension
EDeci Resources Juli] oo Juli] Juli] Juli]
EForecasts Resource Pool .00 (i .00 .00 .00 you want to
EFullTime Resources Juli] oo Juli] Juli] Juli] f | h
EGG Resource Pool Juli] 1] Juli] Juli] Juli]
EGG_B! Ali Resource Pool 20,160.00 672000 00 00 21,120.00 tter, then
EGG_B Resource Pool 53,760.00  30,240.00 00 00 56,320.00
EL Resource Pool 1162660 9,105.60 00 00 12,178.20 select Data »
:: 7 Member Filter — Web Page Dic Member
ESK_ .
ESK_ Filter.
I:I’: —Dimension Hierarch: r Selected Members —————————
- A t
£ 2000 B 0 o —— Member
(23 200 = October F
ilter page
LR
Rt
3 Quarter 1 S
2 Ouarter 2
[ Quarter 3
[ 2004 =
[ Find [ Moveup |[ Move Down
[ ok ][ cancel || Apply |[ Help
This list shows a hierarchy of Thislist shows members that

will appear in the anaytic. To
remove a member, select it and
click Remove.

Figure 2-14 Filtering Members
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4. Usethefollowing controls to select the members you want to display.

Control Description

+ Click to navigate the dimension hierarchy.

Add Adds amember (or members) you have selected in
the dimension hierarchy to the Selected Members
list.

Remove Removes a member from the Selected Members
list.

Remove All Clears the Selected Members list by removing all
members.

Ctrl-click Use Shift-click or Ctrl-click to select more than

Shift-click one member at time.
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5. Click Apply.

A preview version of the analytic appears to show the members you have
selected.

Dimension Hierarchy Selected Members
B £3 FlE = 2003
(3 Quarter 1 B Member
O Quarter 2 filtering is
23 Ouarter 3 J
2 G set to show
o 2 all 2003
(2 2005 r Its
0 2008 Advanced .
ol ]
T 0020= 2003
Reszource (By Pool) Flanned Revenue|Planned tActual RevenuelActual Cosf
HABC Resource Pool .00 .00 .00 .00
HAC Resources .00 .00 .00 .00
HCAD Resource Pool 511,880.00 376,032.00 .an .an
HDeci Resources .00 .00 .00 .00
. HForecasts Resource Pool .00 .00 .00 .00
Resulting ——  @ruimime Resources oo oo oo oo
ana' tiC GG Resource Pool 800.00 320.00 .00 .00
y HGG_BI Ali Resource Pool 187,200.00 6240000 .an .an

Figure 2-15 Filtering Results

6. Click Apply to preview your changes.

7. When you have finished filtering members, click OK to dismissthe Member
Filter page.
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2.4.3 Using the Page Axis

Dimensions you place on the page axis act as an additional filter for data that
appearsin grids and charts. For example, if you move the Business Roles
dimension to the page axis and choose Engineering from the Business Roles drop
down, only data associated with Engineering roles appears in the grids and
charts.

Dimensions moved to the page axis appear at the top of the page. You can include
more than one dimension on the page axis.

B Septemher [ Analytlc without a
E Row Project (By Pool) Hours Commitied[Billabls Amoun]Cost Amoun di R h
ABC Project Pool
Pt B Posl =] | oaC projects Imension on the
EICAD Project Paol 352.00 00 32,20800
m] Column HForecasts Project Pool p@e aXI S
m HIGG Project Pool
ime By Laencar [©GG_BI Project Paol 1,056.00 00 31,680.00
Measures =1 |mLproject Poat 1,408.00 00 164,41920
i P Business Rules [ 4 Business Roes -] ———— Djmensions
Bty moved to the
Project (By Pocl] = page axis
i col [EICAD Project Paol 352.00 00 32,208.00
o EForecasts Project Pool appear here
Tine By Calerdal] = EGG Project Pool
LA Sl ©GG_BI Project Paol 1,066.00 00 31,680.00
Measres =] |aLprojectPoal 1,408.00 00 164,419.20
= _ ESK Proiect Pool
Business Roles | Engineering
September |
B Row miitte d|Billal o Cost Amount])
Foject (8 Fool =] When you select a
] Gotumn 00 6,308.00 . i
dimension member,
Time (By Calenda] = SR 00 1534000 onl y dataassociated
Measires = 1,056.00 00 122,179.20 X
[ Pace with that member
Busiess Fiokes L= appears.

Figure 2-16 Using the Page Axis
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2.4.4 Using the Time (Fiscal Year) Dimension

Most analytics include a Time (Fiscal Year) dimension you can use as an
aternative to the Time (Calendar Year) dimension.

Fiscal yearsaredivided into 13 fiscal periods (also known asfiscal months). With
the exception of the final month, each period is exactly four weeks long and
contains 28 days— making atotal of 364 days. Additional days (beyond 364) are
wrapped into the final fiscal period (13th month). This month has 29 days for
non-leap years and 30 days for leap years.

To make it compatible with your enterprise’s fiscal year, you can configure the
starting month and date for the fiscal year. For more information, see

“Modifying the Fiscal Year” on page 191.

Opportunity (By Pooly s

fit Margin %

E Row EABC Opportunity Pool 00%  1,287,576.78  867,678.00 22H1%
recasts Opportunity Pool Al Time 10.00% 25,100.00 22,800.00 9.16%
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(/701 % Member Filter - Web Page
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(23 FiseYear-2003-00 B
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[Fnal Dwtcome =] (0 FiscYear-2003-05
Engagement Type = (I3 FiscYear-2003-06 . .
Forecast Flag =l &SR] A Member Filter — Web Page Dialog
Client [By Pool) - I:
Time (By Calendar] =
Dimension Hierarchy Selected Memb
SR YFiscYear-2003 =
B 23 FiscYear-2003-00 &

2003-04-07 00:00:0C
O =

[ 2003-04-08 000000

[ 2003-04-09 00000

.1 3 pe.rIOdS (months) [] 20020410 00:020C
inafiscal year [ 20030411 00000
28 daysin aperiod ’ 0 20037044200.10 ?c,

Figure 2-17 Fiscal Periods
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2.4.5 Traffic Lights

You can define and use traffic lights to signal significant data variationsin your
analytics. Traffic lights are useful for quickly highlighting data values that are
outside a specified range.

Adding Traffic Lights

To create a traffic light:

1. Open an anaytic and display the grid view.

2.  Select the dimension members you want to monitor.
To monitor a complete column or row, select the column or row heading.
You can also select agroup of cellswithin acolumn or row.

3. Select Advanced » Traffic Lights from the context menu.
A Traffic Light pane appears.

4. Enter aname for the traffic light.

By default the traffic light is named for the data to which it applies, but you
can enter you own custom name if desired.
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5. Set thetrigger conditions for the light.
You can define your own custom conditions or use the Condition Wizard to
create a standard, three-range condition.

2} New Traffic Light -- Web Page Dialog x|
Click to open the o
Condition Wizard. ——

Condition 1

Or, usethese —— . [Valoes Betnean = | and|
. Description:

settings to create a :

custom condition.

[ Style. | [ Remave |

7} Traffic Light Wizard -- Web Page Dialog x|

th

Enter values (inclusive) for the alert and caution thresholds and the
required traffic light conditions will be automatically created.

Enter aname for

Traffic Light Name [requited

the trafﬂ C I |ght — 1 |Measures=Flanned Rewvet Alert threshold:

Traffic lights will be applied to cell 0
1: {Measures:Planned Revenus}

Click to add more

conditions, —— fn et

Use the Condition

Wizard to quickly create

guicety

athree-range condition.

Figure 2-18 Setting up Traffic Lights
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6.

If you create your own conditions, specify the following for each condition:

Item

Values

Description

Enter a condition value and amount. Select one of
the following logic operators from the Values
menu.

- Values Between. Specifies arange of numbers.
Any value within this range will trigger the
condition.

- Values Equal To. Specifies an exact number.
Values that match this number will trigger the
condition.

- Values Greater Than (>). Specifies a minimum
number. Values larger than this number will
trigger the condition. You can aso specify
Greater Than or Equal To (>=).

- Values L ess Than (<). Specifies amaximum
number. Values less than this number will trigger
the condition. You can also specify L ess Than or
Equal To (<=).

- Any Value. Any value will trigger the condition.

Description

A brief text description of the condition. Thisfield
isoptional.

Style

Click Style to set display characteristics for the
condition. You can set the foreground and
background colors and font. Values that meet the
condition specified will appear in the style you
define.
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Amounts you enter for conditions must be whole or decimal numbers only,
no commas or other types of separators are allowed.

7. Toadd anew condition, click Add Condition. You can create as many
conditions as desired.

2} New Traffic Light -- Web Page Dialog x|

o

Condition Wizard.._

1~ Condition 1 |

[Values Less Than (<) =l [10.000
Description:
[t [ Swle. | [ Remove

i~ Condition

[Values Between =l [roooo and [100,000
Description:
toderate ‘ Style... | | Remove

1~ Condition 3
[Values Between =] [100.000 and [150,000 L
Description:

[Good [ Style. | [ Remave |

[~ Condition 4

Traffic Light Name (required):
|Mea9ures:P\anned Revenue

Traffic lights will be applied ta cels using the scopels],
1: {Measures:Planned RevenusHResouce By PooltL Resource Pool{Time (By Calendart May}

T = W

Figure 2-19 Traffic Light Conditions
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Be careful when setting condition order. Each data cell is evaluated starting
with the first (top-most) condition listed and continuing until a condition is
matched. Once a condition is matched, an alert (as appropriate to that

condition) isapplied to the cell. Additional conditions beyond the first match
areignored for that cell.

When you' ve finished creating conditions, click Apply to view the results.
9. Click OK to save your changes.

EABC Project Pool

HAC Projects

EBI_lrina Project Pool 00 .00

EICAD Project Pool 1,579,945.60 NSEEEEN  346.120.00

HCapacity Project Pool

EForecasts Project Paol 1,485872.00 NEDIMEENEN  294,106.80

FIGG Project Pool 322668000 [NGINEDOE 1,708,560.00
G_BI Project Pool 1,054,781.97 | EEERENEE  445299.99

Project Pool 7 New TraliT Light - Web Page Dialog

in Project Pool

= 11,285,775 4 [ EEEEEENEE

Project Pool 4706,27200 _3,002,847.50 &

— 00

ESK_Flex Project Pool o0 _
ESK_PartTime Project Pool i) _ r Condition 1
EHTony Project Pool o0 [ [Values Greater Than or Equal (»=) -] |5unnnnu ]
EUnassigned Projects Description:
FEUnknown [alert [ Remave
EZ Project Pool 00 [ it
EZZ Toor Project Pool

[Valies Greater Than or Equal =) =] [2000000.0
Deseription:
[Cavtion [Remave

[~ Condition 3
AnpValue -
[Normel [ Remave

Traffic Light Name (required):
[Measures-Planned Cost

Figure 2-20 Using Traffic Lights
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Managing Traffic Lights

To manage traffic lights:
1. ChooseTools » Manage » Traffic Lights.

A pane appears with alist of traffic lights defined for the analytic. Use this

pane to apply, edit, or remove traffic lights.

2. When you have finished making changes, click OK.

R Manage Traffic Lights -- Web Page Dialog

Hove Up

Move Down

[ Edit...

Delete

I

Cancel

Click to changethe
order of how traffic
lights are applied.
Lights at the top of
the list are applied
first.

To delete atraffic
light, select alight
and click Delete.

Figure 2-21 Managing Traffic Lights

2.4.6  Setting Data Options

After you have finished arranging the data layout and filtering members, you
may want to use the Data Options page to make additional display changes. For
example, sometimesiit is easier to read agrid if zero (0) and null values are

hidden.
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To set Data Options:
1. Open ananalytic.

You can select an analytic from the Jump to drop down or click an analytic
on the Bl home page.

2.  Select Data » Options.
The Data Options page appears.

/3 Data Options -- Web Page Dialog x|

o

¥ Keep selected member on drill down

" Remove unselected members on drill down
¥ Perform operation in all nested groups

¥ Use aliases

™ Suppress missing rows
Select these 7*&' Suppress missing columns
. . I” Suppress zero rows & columns
optionsto hide  Surmren bt
null values. ¥ Enable show & hide

" Enable keep & remove
 Diill Dawn Behavior

= Drill down to next generation
SeI ect one Of these " Drill down to all descendants
options to set drill

down behavior.

" Drill down to leaf members
" Drill down to siblings

" Drill down to same generation

- Parent position
" Display parent before child
" Display parent after child

' Default parent placement

0K || Cancel |[ Apply || Help

Figure 2-22 Setting Data Options

3. Tohide null values, check the following:
¢ Suppress missing rows.
¢ Suppress missing columns.
¢ Suppress zero rows and columns

4. Select additional options as desired.

5. Click Apply to preview your changes. Then, click OK to dismiss the page.
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2.4.7 Using Format Masks

You can use format masks to modify data values in grids and charts. For
example, you can use a Thousands mask on charts to display datain thousands
(000's) or a Euro mask on selected grid cells to include a Euro symbol with
monetary amounts.

Applying Format Masks to Charts

15,000,000
12,500,000
10,000,000
Chart without 750000
5,000,000 15,000k
2,500,000 — — 12,500K
0 J I 10,000k
Flarnad Revef
i 7 500K
ABC Project Pool §:
® CAD Project Pool ¥:
B GG Project Pool 000K
® Jun Project Pool
B SK_Project Pool
TK Project Pool 25004
Unknown
Chart with a oL - 1 ‘
Plannad Revenug Plahned Cost Planned Margin Assighed Resources
Thousands Measures
for mat mag< ABC Project Pool ™ AC Projects = BI_lrina Project Pool
B CAD Project Pool B Capacity Project Pool ~ Forecasts Project Pool
I - aj B GG Project Pool GG_BI Project Pool IC Project Pool
wp I . ¥ Jun Project Pool B L Project Pool Hew Project Pool
B SK_Project Pool SK_Flex Project Pool SK_PartTime Project Pool
TK Project Pool B Tony Project Pool Unassigned Projects
Unknown ™ Z Project Pool W ZZ Toor Project Pool

Figure 2-23 Format masks
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To apply a format mask to a chart:
1. Open an anaytic and display the chart view.
2. Select the data you want to mask.
¢ You can select achart axis (for example, X or Y).
+ You can select one or more dimensions or measures.
3. Select Format from the context menu.

4. Select amask type from the M ask menu.

[ 15000
;| 12500 N ‘2 FOrmat Aixis -- Web Page Dialog x|
;| 10000 —— m
i General X Axis 1 Axis
7500,  Unhide Al
Axis Title:
: Adwanced 3 -
§ 50004 Swap dwes
rScale

| 25004 Chart Options . Sieedter
: Chart Types Minimum: ¥ Auto

o NI F Maximum: ¥ Auto
Planned Revenue  Planned Cost Plan
Measures I” Use log scale
Mask:
Mo Mask -
Mo Mask

Farenthesis

Hillons
Percertage
Dllars

Ewos

2 decimal places
Integer

Custom

0K |[ Concel |[ Apply ][ Help

Figure 2-24 Predefined mask types
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You can select apredefined mask type or choose Custom to define your own
custom mask. (See “ Creating Custom Masks’ on page 101 for more
information on creating custom masks.)

Click Apply.
After afew moments, the chart reappears with the new, masked values.

Applying Format Masks to Grids

To apply format masks to a grid:
Open an analytic and display the grid view.
Select the cells that require the format mask. You can:

1
2.

*

*

Select one or more cellsin arow or column.

Select arow or column heading to apply the mask to al datain a
dimension.

Use Ctrl-click or Shift-click to select multiple cells or multiple
headings.

Choose Advanced » Format Mask from the context menu.
A Format Mask pane appears. Use this pane to create a new format mask.

To create a format mask:

*

Enter aname for the mask. By default, the mask name describes the data
range you have selected (for example, one or more dimension names or
a specific cell name).

Choose amask type from the Format type menu. You can choose a
predefined type or create a custom mask. See “ Creating Custom
Masks’ on page 101 for more information on creating custom masks.

When you select a mask type, the example data in the pane changes to
show the mask you selected.

Click Apply. The mask is applied to the data you selected.
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Format masks you create are stored with the selected data. They are not
automatically available for other dimensions.

5. If the datayou selected already has format masks defined, a pane appears
with alist of masks.

Select an existing mask to apply or choose Create a New M ask.

Only masks defined for the currently-selected cells (or dimensions) will
appear in this list. Masks defined for other, unselected cells (or
dimensions) will not appear.

Table 2-1  Predefined Mask Types

Name Description

Dollar Appliesadollar symbol ($) to the data selected.

Euro Applies a Euro symbol

Integer Truncates decimal values. For example, 123.54
becomes 123.

Thousands Displays datain Thousands (OOO’s) and adds aK
symbol. For example, 2,500 becomes 2.5 K.

Millions Displays datain Millions (000, 000's) and adds an
M symbol. For example, 250,000,000 becomes
250 M.

Occasionally, you may have more than one mask applied to datain agrid. For
example, adimension could have a Dollar mask and a Thousands mask. You can
set the order of how masks are applied. For more information, see “ M anaging
Format Masks’ on page 100.
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Managing Format Masks

Usethe Manage » Format Masks command to manage format masks for your
site and make global changes. You can edit or delete existing masks and control
how masks are applied.

Use caution when making change. Changes you make with the Format
Mask pane apply to all analytics defined for your site.

To manage format masks:
1. Openananalytic.
2. Choose Tools» Manage » Format Masks.

A pane appearswith alist of al format masks.

/B Manage Format Masks — Web Page Dialog x|

7]

Format Masks:

Percentage/Integer
Another Mask
Dollars

Demand Mask

Move Down

Delete

Cancel

Figure 2-25 Managing Format Masks
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3.

*

Select amask and choose one of the following:

+ Edit. Click to make changes to an existing mask. Changes you make
apply to al cellsthat use this mask.

+ Delete. Click to delete amask. When you delete amask, cell datais
restored to the values that appeared before the mask was applied.

+ MoveUp or Move Down. Use these buttons to set the order in which
masks are applied (starting with the top of thelist) to cellsthat have
more than one mask. For example, you might want to apply a mask that
rounds values to two decimal points before (or after) applying a
currency mask.

When you have finished making changes, click OK.

Creating Custom Masks

When you create custom masks, Primavera recommends copying an
existing mask definition, then making changes as desired.

To create a custom format mask:

1.

ok~ wDd

Open an analytic.

Select the data you want to mask.

Select Advanced » Format from the context menu.

When the Format M ask pane appears, choose Format Type » Custom.

Enter a new mask definition. You can toggle through the existing formats to
see the types of symbols and building blocks that can be used in a mask.

Analytic Applications 101



Business Intelligence

The following are some common symbols you can use in format masks:
0 (required digit)
# (optional digit)
$ (adds a dollar symbol)
‘%’ (adds a percent symbol)
6. Click Apply to preview the mask you created.
7. Make changes as desired, then click OK to save the new format.

When you create custom format masks, you might create a mask that
results in no data displayed. Make sure you check the example first
before applying the mask.
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2.4.8 Saving Your Changes

When you have finished making changes to customize the analytic, save your
new layout view as a custom analytic.

To save your changes:

1. Inananalytic you have customized, click @ at the top of the page.
The Save as Custom page appears.

Save Custom Analytic . . .

Name:
|Regmn1Frmems

Description:(Optional)
Project Financials for Region 1 (SIaIus:AH)| d

I Cancel l [ oK ]

Figure 2-26 Saving a Custom Analytic

2. Enter aname and description for the new analytic you created.
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3. Click OK.

You can now open the analytic by clicking the Custom Analytic link on the
Bl home page or by selecting Custom Analytics from the Jump to drop

down.
Welcome to Business Intelligence
Click to show | Custom Analytic Project Status
. | 0! Displays custom analytics defined far your Displays projects b
Custom analyt' cS enterprise praject manager, al
defined for your .
. Project Financials Resource Utiliz:
mterprlse. Displays financial atiributes of projects, such as ] Displays actual util
planned and actual cost, headcount, material selectresources by
costs, expenses, and % work complete. You pool, organization L
can select projects by poal, organization unit, resource manager,
and project manager.
S
Select a Custom Analytic
Pipeline custom +|  Region1Projects
FP_GG
Project Finacial custom
Project forecast custom
PROJECTFORECAST
Select acustom ————————— | [t srwmas cosem
RE_GG_Chart "
. - Project Financisls for Region 1 (Status = All)
analytic and
click OK.
I Cancel l l OK
Figure 2-27 Selecting a Custom Analytic
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2.4.9 Deleting Custom Analytics

To delete a custom analytic:

1. Click Edit Custom Analytics at the top of the Bl page.
A page appears with alist of custom analytics. Only the custom analytics
your Bl role allows you to access appear in thislist.

Custom Analytics o

Name Description Action

Gena Region 1 projects by J. Menzian Delete - ||

time30451 Delete .

TimeSheet | Development project for Amarco Clients wee. —— Click to delete an

analytic.

Figure 2-28 Deleting a Custom Analytic

2. Click Delete next to the analytic you want to delete.
3. When you have finished deleting analytics, click the close box at the top of
the page.

You can delete custom analytics, but not the default analytics shipped
with BI.
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2.5

Custom Analytics — An Example

This section contains asimple, start-to-finish example of creating a custom
analytic. You can useit asamodel for creating your own custom analytics.

This example shows how to modify the Project Financias analytic to include

additional project dimensions, highlight afew key project pools, save your
changes as a new analytic, and create a PDF snapshot.

To create the analytic:

1. Click Project Financials on the Bl home page.
The Project Financials analytic appears. This analytic shows planned

revenue and costs for all active project pools over the next three months.

Flanne:

1,369,43

[EABC Project Pool 3,743,0232.80 2,374,402.20
EAC Projects
[ECAD Project Pool 1,579,945.60 1,027,032.80 652,91
[EForecasts Project Pool 3,871,643.20 281235200 1,058 28!
[EGG Project Pool 1,395,200.00  755,440.00 639,761
[EGG_BI Project Pool 1,054,791.97 6509,431.98 445 20!
roject Pool 12,680,588.32 9,510,266.56 3,170,232
_ Project Pool 4,652,272.00 2.880,807.60 1,771 46.
Flex Project Pool .0n a0
_PartTime Project Pool .0n a0
[ETK Project Pool 1,820,420.00 76168000 1,068 3200
ETony Project Pool .0n a0
Eunknown
®Z Project Pool
EZZ Toor Project Pool 0o a0
4 i

14,000,000 —

12,000,000 -

10,000,000 —

8,000,000

£,000,000

4,000,000

2,000,000

o T

—

Planned Revenug

Planned Cost

T
Planned Margin
Assigned Resources

Measures

+ ABC Project Pool

# CAD Project Pool

# GG Project Pool

# LProject Pool

+ SK_Flex Project Pool
& TK Project Pool

# Unknown

 ZZ Toor Project Pool

@ AC Projects

# Forecasts Project Pool

+ GG_BI Praject Pool

+ SK_Project Pool

# SK_PartTime Project Pool
+ Tony Project Pool

+ Z Project Pool

Figure 2-29 Project Financials
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2. Changethe grid orientation by rearranging the information in rows and

columns.

+ Click

on the tool bar. A layout version of the analytic appears.

¢ Openthe Measures drop down and select M ove to Row Axis. The
analytic measures (Planned Revenue, etc.) change from columnsto

rows.
B Row |3 iFann
EABC Project Pool 2,421,626.00  1,527,964.00
Project By Pool) - [HAC Projects
m Cal 1,579,945.60 1,027,032.80 552,812.80 1.00
vt 1,486,872.00 1,201,765.20  294,106.80 6.00
m GG Project Pool 1,396,400.00 755,920.00 640,420.00 3.00
[ e EIGG Bl Proiect Poo 1.054.791,97  509.491.98  446.209.39 10.00
Measures - e
E Row Planned Rewenue 4,008,600.00 &
. Planned Cost 2,481,636.00
Project [By Pool] = HAHC Project Pool Planned Margin 1,627,364.00
Move to page axis Measures x Assigned Resources §.00
mﬂvzlﬂ gl‘[ﬁf il col PFlanned Revenue
Member Filer. olumn - Flanned Cost
E‘Hama—;[ ERERIDIECS Planned Margin
Project Status :l' Assigned Resources
E o Planned Revenue 1,578,545.60
. Planned Cost 1,027,032.80
HICAD Project Paol Planned Margin 552,812.80
n Other Assigned Resources 1.00
Planned Revenue 1,495,872.00
Org Unit (B Name] = m Planned Cost 1,201,765.20
| HForecasts Project Poal . e Margin 294,106.50
Assigned Resources 6.00
Pioject [By Ora Manage) -] Bl ME A Bovan. 4308 400 00

Figure 2-30

Moving Measures to Rows
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3. Changetheanalytic to include information about all projects (hot just Active
ones).
¢ Select Project Status » Member Filter. The Member Filter appears.
+ Inthedimension hierarchy, open the All Project Satus folder and

select Active, Complete, and Prospective.

¢ Click Add to include these project status types in the Selected
Memberslist.
¢ Click Apply to preview your change. Then click OK to exit the

Member Filter.

“JMember Filter -- Web Page Dialog x|
~Dimension Hierarchy ~Selected Members
= All Project Staty
=] roject Status active
'L._fﬁj Complete
Prospective
<< Remove All
Find Move Up | [ Mave Dawn

Project (By Pool) Measures g Complete | P

Planned Revenue  4,009,600.00  6,000.002,286,789.60 =

b Planned Cost 2,481,636.00  3,000.001,505,834.40

[ABC Project Pool Planned Margin 152786400 300000 780,955.20

Azsigned Resources 8.00 oo 8.00

Planned Revenue oo

. Planned Cost oo

BAC Projects Planned Margin oo’

Azsigned Resources oo

Planned Revenue 1,578,945.60 1,483,162.40

. Planned Cost 1,027,032.80 1,156,300.00

HICAD Project Pool Planned Margin 552,912.60 328,862.40

Azsigned Resources 1.00 2.00

Planned Revenue 1,495,872.00 1,200.00

. Planned Cost 1,201,765.20 800.00

BForecasts Project Pool -, o warmin 294,108.60 400.00

Azsigned Resources B.00 oo

Planned Revenue 1,396,400.00 42,240.00

Figure 2-31

Including Active, Complete, and Prospective Projects
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4. To emphasize afew important projects, reduce the number of project pools
that appear in the analytic.

+ Select Member Filter from the Project Pool drop down. The Member

Filter appears.

¢ Click Remove All. Thisremoves all project pools from the Selected
Memberslist.

+ Inthedimension hierarchy, select afew of the project pools you want to
highlight.

¢ Click Add to move these project pools to the Selected M emberslist.
¢ Click Apply to preview your changes. Then click OK to exit the

Member Filter.
ZMember Filter - Web Page Dialog x|
" Dimension Hierarchy Selected Members
(11 ABC Project Pool = CAD Froject Paol
. GG Project Pool
(13 AC Projects m L Fraject Foal
RN TAD Pramet Poo TK Project Pool
(1 Forecasts Project Por
[BYG G Pooicct Poo S
(11 GG_BI Project Pool << Remove All
&
[:_1 SK_Project Pool
4| W
| Find [ MoveUp |[ Move Down
[ ok ][ cancel |[ Apely ][ Help

Figure 2-32 Emphasizing a Few Project Pools
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5. For additional visual impact, change the analytic to show the grid positioned
above the chart.

+ Click to toggle back to page view.

¢ Makesure m and &l are selected to show both the grid and chart.

¢ Select Tools » Present Options. The Present Options page appears.

¢ Sdect Chart and Grid Orientation » Stacked. Then click Apply to
preview your changes.

+ If necessary, drag the pane slider bar up or down to see both the grid and
chart in the data pane.

Pla e | 157984560 " 1gs,
Planned Cost 1,027,032.80 1,281,100.00
EICAD Project Pool o 1o wargin 663,612.60 347,603.40
Assigned Resources 100 300
Planned Revenue | 1,385,200.00 18,400.00
g Planned Cost 755,440.00 7.380.00
BGG ProjectPool b o Wargin £36,760.00 11,040.00
Assigned Resources 0 300
Planned Revenue 12,680,508.324,868,165.526,204,484.84
- Planned Cost 9510,266.56.3,428,161.364 501.407.45
BLProject Pool b o argin 3470,321.761,440,004.161,703,077.38
Assigned Resources 48.00 200 21.00
Planned Revenue  1,830,480.001,050,96000  1,220.00
Planned Cost 76168000 43688000  610.00
EITKProject POOL b ned Margin 1,066,800.00 61408000  610.00
Assigned Resources 400 00 300
= — If necessary,
By L Project Fool —_~. R
Pool)
drag the dider
down to see
the complete
500,000 r F g .
T T T
Active Complete Prospective

Figure 2-33 Changing Grid and Chart Orientation
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6. Saveyour changes as a custom analytic.

This enables you to view datain this format without having to recreate your
changes each time you open the analytic.

¢ Click @

+ Namethe analytic, MyProjects, and add a brief description. The
description is optional.

Save Custom Analytic . . .
Name:
|MyProJect

Description:{Cptional)
A custom analvtic that shows all project status far my pmiects.l ;I

l Cancel ] I OK l

Figure 2-34 Saving a Custom Analytic
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7. Create a PDF snapshot of the analytic. Snapshots are useful for sharing
information with users who do not have accessto Bl.

¢ Select Custom Analytic from the Jump to drop down.
+  When alist of custom analytics appears, select M yProj ects.

+ Click E Then, select PDF options as desired.

A PDF version of the analytic is saved to the location you specify. You can
distribute this version to others as desired.
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3.

Capacity Planning

A company'’s ability to predict gaps between project staffing needs and resources
iskey to corporate success. Corporationsthat can accurately identify and address
mismatches between resource supply and project demand have a strategic
advantage in the market place.

Capacity planning is amethodology for accurately modeling resource supply and
project demand. It helps enterprise professional's assess current capacity
requirements and predict future trends.

This chapter describes how to use capacity planning. Topics include:

*

*

*

*

About Capacity Planning

How Capacity Planning is Calculated — An Example
The Capacity Planning Report

Using the Capacity Planning Analytic

Changing the Matching Model

113



Capacity Planning

To meet your capacity planning needs, Primavera provides two levels of support:

+  CP Report. Included with the Primavera operational applications, the CP
report enables group, program, resource, and project managers and other
usersto get aaquick summary of potential gaps or surpluses associated with
project demands and resource supplies.

¢ CP Analytic. Included with BI, the CP analytic enables financial managers
and other business analysts to perform detailed capacity planning analysis
based on avariety of data dimensionsthey choose in order to understand and

address potential gaps.

__ [Time (By Calendar)[ 2004 -

Bond, James 1,812.00

Whits, Lora 1,512.00 il 1,512.00 |
EL Resource Paol ~ 78,624.00 8,454.00 BEE4TO4 30,368 50—
Alsxis, Chris A 1,512.00 216.01 1,295.99 il
Aoy, Will A 1,512.00 il 1,512.00 gad
Banks, Angel A 1,512.00 756,00 786,00 g
Beatty, Mery A 1,512.00 216,01 1,295.99 584 1 1 500
TR 1,512.00 216.01 1,295.99 gad

: 1,512.00 404,00 602,00 g

13 - Microsoft Internet Explorer

v Next Last Goto

age [N o5 Search Download/Print

Dernand by Period
1600
1400
BFilled Demand
1200
mUnfillable Demand
_ OFillable Demand - ‘U”“SENE Supply
£ 1000 PEHAY
E —
% 200 Z} E¥_CapacityPlanning - Microsoft Internet Explorer =] ]
g NavBar First Prev Mext Last Goto Page of 6 [INEIR| Search
2 600
400 Demand Capacity Planning
200 Location Jobs Title Totai Demand  Fitied Demand  Fiffed Demand
Ratio
0 Analyst 168.00 0.00 0.00%
April 1
Consultant 168.00 0.00 0.00%
_ Dev Engineer 336,00 0.00 0.00%
QA Engineer 504.00 162.00 33.33%
Engineering Manager 168.00 0.00 0.00%
Qi Manager 336,00 0.00 0.00%
Location Totals: 1,680.00 168.00 10.00%
d st

Figure 3-1  Capacity Planning Analytic and Report

114 Analytic Applications



Capacity Planning

3.1 About Capacity Planning

Capacity planning helps business managers answer the following questions:

+ Arethere project positions to fill where no eligible resources are available?
+ Dol have resources where no eligible positions are avail able?

+ Am| assigning resources to project positions quickly enough?

Leveraging information defined in Primavera operational applications, Capacity
Planning provides you with answers to these questions. You can view capacity in
terms of demand or supply. Demand is captured through position definitions and
supply is captured through resource profiles.

By determining the eligibility of a given resource to fulfill a given position
definition, Capacity Planning attempts to reconcile position definitions with
resource profiles and alerts you to any potential gaps or surpluses.

3.1.1 Access Control for Capacity Planning

Userswho have permission to view reportsin Primavera operational applications
have permission to run capacity planning. Project and resource datavisiblein the
report is compatible with the user’s permissions in the operational applications.
For example, if auser can view Project Pools A and B, but not C, the user cannot
run areport that includes results for Project Pool C.

Userswho have the Forecast Analyst role assigned in Bl can use the CP analytic.
In this case, enterprise-wide project and resource datais available for analysis.

System administrators or IT programmers can customize report parameters and
redefine project to resource matching criteria. They can also set how often
capacity planning information is updated. For more information, see “ Changing
the Matching Model” on page 135.
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3.1.2 Data Processing for Capacity Planning

Both the CP report and the CP analytic gather information from Data Mart
instead of from the operational databases. Therefore, you must have Data Mart
installed to use capacity planning.

The capacity planning analytic requires multi-dimensional OLAP cubes. To
create the OL AP cubes, Primavera provides a capacity planning job that runsasa
separate, post-processing job to the standard ETL processing for Data Mart. This
job extracts capacity planning data separately from other analytic data and
creates the appropriate OLAP cubes. For the analytic, matching keys are set
using parameters in the data mart properties file. System Administrators can
change properties as desired.

Because of processing time and the longer-term nature of the information.
Primaverarecommends you only process capacity planning information once per
week.

The process flow for creating OLAP cubes includes:

1. Define projects and resourcesin the operational applications. Use Team
Builder to define project-to-resource matching criteria. Capacity planning
uses the global default settings only (not local user settings).

2. Set matching model criteriain the data mart properties file. For more
information, see “ Data Mart Properties’ on page 136.

3. Runthe DataMart ETL process to extract data from the Primavera
operational applications database.

4. Run the capacity planning post-processor to add capacity planning datato
the data mart and build the appropriate OL AP cubes.
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3.1.3 Comparison of CP Report and CP Analytic

Depending on access permissions, users have the option of using areport or an
analytic for capacity planning. This section describes some of the features and
benefits of each.

Benefits of the CP report include:

*

The report is best suited for quick-look use. It provides a reasonable,
contained view into the future (approximately 6 months).

Thereport is are broken down by the same dimensions as the pre-set
matching criteria (Job Title and Location). The report can be customized, but
only two dimensions are allowed.

Users specify demand by selecting one or more projects or project pools.
They specify supply by selecting one or more resource poals.

The report provides simple comparisons with no ability to drill-down. It
highlights major inconsi stencies between scheduled work and resource
availability, but not detailed capacity nuances.

The report can be run periodically and used as part of an organization's
standard business process, or ad hoc to address specific problems.

Benefits of the CP analytic include:

*

The analytic has more flexibility than the report. Analysisis done on the
dimensions that are not part of the matching criteria. For example, auser
could match resources to positions based on Skills and analyze supply and
demand based on Services.

The analytic provides along-term planning tool. Business analysts can use
thistool to determine future business patterns.
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3.2 How Capacity Planning is Calculated —
An Example

The following is a simple example to illustrate the basic computational
methodology used to provide capacity planning results. You can use this example
as afoundation for understanding your own capacity planning results.

Important!

For simplicity, this example uses a simple true/false model to match resources to
positions. In the actual CP application, the matching model can be based on a
much more detailed set of criteria, including match thresholds, factor weighting,
and qualification weighting.

Also, this example shows computations for only afew resources and a few
positions. In the actual CP application, large collections of resource pools and
projects or project pools can be included.

3.2.1 Computational Passes

Capacity planning is based on two major computational passes:

¢ Allocation of Resource Hours to Meet Demand
In this pass, the system levels resources across each position. See below for
details. Because this pass maximizes the allocation of resource hours,
resources that are eligible for multiple positions may be over allocated.

+ Allocation of Position Hours to Meet Supply.

In this pass, al available position hours are leveled across resources. See
below for details. Because this pass maximizes the filling of position hours,
positions that have multiple eligible resources may be over filled.

Capacity planning then reconciles and displays the results of each pass and
flags discrepancies between the two.
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3.2.2 Example Scenario

In this example, there are two positions (Position 1 and Position 2) and three
resources (Resource A, Resource B, and Resource C).

Position Demand Hours

Position 1

Resource Supply Hours 60
Resource A 40 Yes
Resource B 20 Yes
Resource C 30 No

Demand hours:
+ Position 1 has 60 hours of demand.
+ Position 2 has 10 hours of demand.

Supply hours:

¢ Resource A has 40 hours of supply.
¢ Resource B has 20 hours of supply.
¢ Resource C has 10 hours of supply.

Eligibility:

Position 2
10

Yes
No

Yes

+ Resource A isédligible for both Position 1 and Position 2.
+ Resource B iseligible for Position 1, but not Position 2.
+ Resource Ciseligible for Position 2, but not Position 1.
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3.2.3 First Pass: Allocation of Resource Hours to
Meet Demand

In thefirst pass, the system levels the resources across each position. Essentialy,
the available individual resource hours are prorated to the available hours from
all resources against the demand. The goal of thisis to maximize the meeting of
demand.
The results shown are based on the following formula:

RH/ARH * PH

where:
RH = Available hours available for the resource
ARH = Available hours for all resources matching the position
PH = position hours

This gives an allocation of resource hours to positions attempting to meet all
demand. For simplicity, rounding done to tenths and done to keep total s matching
in the example.

Results of the First Pass

For Position 1:
+  Resource A working on Position 1 =40/ (40 + 20) * 60 = 40
+ Resource B working on Position 1 =20/ (40 + 20) * 60 =20

120 Analytic Applications



Capacity Planning

For Position 2:
+ Resource A working on Position 2 =40/ (40 + 30) * 10=5.7

+ Resource C working on Position2 =30/ (40 + 30) * 10=4.3

Position Demand Hours

Position 1 Position 2
Resource Supply Hours 60 10
Resource A 40 40 57
Resource B 20 20 0
Resource C 30 0 4.3
In this pass:

+ Position 2 can befilled by either Resource A or C. Resource A has 40
available hours and Resource C has 30 available position hours
(approximately, a 4:3 ratio).

¢+ UsingtheRH/ARH * PH formula, all 10 hours of Position 2 arefilled using
this4:3 ratio. The result is 5.7 hours from Resource A and 4.3 hours from
Resource B.

+ A similar computation was done for Position 1 using a2:1 ratio (40 available
hours from Resource A and 20 available hours from Resource B).

+ Noticethat this allocation resultsin Resource A being over allocated
(Position 1 = 40 hours + Position 2 = 5.7 hours. Total = 45.7 hours). Thisis
reconciled in the summary table. See“ Summary Table’ on page 124.
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3.2.4 Second Pass: Allocation of Position Hours to
Meet Supply

Next, the system levels the positions across resources. The resources' available
hours are prorated for each individual position demand hours against the demand
hours of all the possible positions the resource can fill. The goal isto maximize
the alocation of supply.
The results shown are based on the following formula:

PH/TDH* RH

where:
PH = Demand hours of the individual position
TDH = Total demand hours of all positions the resource can fill

RH = Resource's available hours

This gives an allocation of demand hours to resource availability hours
attempting to maximize utilization of the supply. For simplicity, rounding is done
to tenths and to keep totals matching in this example.

Results of the Second Pass

For Resource A:
+ Position 1 is being satisfied by Resource A = 60/(60 + 10) * 40 = 34.3
¢ Position 2 is being satisfied by Resource A = 10/(60 + 10) * 40 =5.7
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For Resource B and C which each only have one position:

*

*

Position 1 is being satisfied by Resource B = 20/20* 20 =20
Position 2 is being satisfied by Resource C= 10/10* 30 = 30

Position Demand Hours

Position 1 Position 2
Resource Supply Hours 60 10
Resource A 40 34.3 57
Resource B 20 20 0
Resource C 30 0 30
In this pass:

*

Resource A can fill either Position 1 or Position 2. Position 1 has 60 hours
and Position 2 has 10 hours (a 6:1 ratio).

Using the PH/TDH*RH formula, al 40 hours of Resource A are supplied
using this 6:1 ratio. This resultsin 34.3 hours supplied to Position 1 and 5.7
hours supplied to Position 2.

Resource B can only fill Position 1. Therefore, supply hours from Resource
B do not have to be proportionately allocated across positions. Instead, all
supply hours from Resource B are supplied to Position 1 (20 hours).
Similarly, Resource C can only fill Position 2, therefore, all supply hours
from Resource C are supplied to Position 2 (30 hours).

Noticethat this allocation results in Position 2 being oversupplied (Resource
A =5.7 hours + Resource C = 30 hours. Total = 35.7 hours). Thisis
reconciled in the Summary table. See“ Summary Table” on page 124.
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3.25 Summary Table
This table shows each row with both calculated values. Thefirst value is the

alocation of hours attempting to meet demand. The second value isthe
alocation attempt to use all supply.

Position Demand Hours

Position 1 Position 2
Resour ce Supply Hours 60 10
Resource A 40 40/34.3 5.7/5.7
Resource B 20 20/ 20 0/0
Resource C 30 0/0 4.3/30

Where the two cal culations closely match, a high degree of confidence about the
alocation is presumed. However, results like Resource C’s allocation to Position
2 indicate a problem.

In a production environment, the actual matching criteriafor your enterpriseis
taken into consideration. When this matching criteriais combined with
calculations spread across a large numbers of resources and positions, statistical
accuracy is leveraged and the result is a useful tool for CP planning and analysis.
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3.3 The Capacity Planning Report

In the capacity planning report, you define the scope for the demand (one or more
projects or project pools) and the scope of the supply (resource pools).

You can generate a capacity planning report to view supply or demand. A supply
report shows capacity planning results in terms of which resources can be used.
A demand report shows capacity planning resultsin terms of which positions can
be filled.

The CP report includes a summary graph to illustrate the results and a detail page
with numeric data.

3.3.1 Creating a Capacity Planning Report

To create a capacity planning report:
1. Login to the Primavera application.

To open the application, enter its URL in a supported browser. ThisURL is
case sensitive and follows the format:

http:// [HOST] /primavera/web

where [HOST] isthe name of the computer where the analytic applications
web server resides. If your enterprise relies on Secure Socket Layer (SSL)
encryption, the protocol, or first part, of the URL must be HTTPS. For
example:

https:// [HOST] /primavera/web
2. When alogin page displays, enter avalid username and password.
3. Onthe main menu, select Capacity Planning.

A list of report parameters appears.
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Selection Parameters

Project Pools /Projects: (¥ Project Pools & Projects

Project Pools: * 9 L Project Poal

Resource Pools: * 9 L Resource Pool

Include Inactivity I - l
Commitments: Firm Only =

Analy_ze Capacity * Demand
Planning for:

" supply
Show Time Intervals as: (" calendar

' Fiscal Period

& sub-period

Figure 3-2  Parameters for the Capacity Planning Report
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4. Select the information you want to include in the report. Parameters include:

Name

Selection Parameters

Description

Project Pools/Projects

Specifies whether the report will include Projects
or Project Poals.

Project Pools

Project poolsto include in the report.

Resour ce Scope

Resource poolsto include in the report.

I nactivity
Commitments

Controls how non-project resource hours are
reported.

All. The report includes resource hours for
tentative and firm non-project assignments.

Firm Only. The report includes resource
hours for firm (but not tentative) non-project
assignments.

None. Only project related resource hours are
included in the report.

View Parameters

Analyze for Demand

Analyzefor Supply

Creates a supply or demand report based on your
selections. A demand report shows capacity
planning results in terms of how project hours can
befilled. A supply report shows capacity planning
resultsin terms of how resource hours can be used.
See below for details.
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Name

Timelntervals

Description

Time intervals for report results. The report
displays approximately six months of data.

Calendar. Results displayed in months.

Fiscal Period. Results displayed in fiscal
periods (for example, 2004-01, 2004-02).

Sub Period. Results displayed in sub-periods.
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3.3.2 Demand Report
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Figure 3-3 Demand Report

A demand report shows capacity planning issues in terms of project hour
requirements. Thefirst page of the report shows a summary chart with the critical
gap information included. Additional report pages show a detailed table of report

data sorted by job title and location.
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Information in a demand report includes:

Column Description

Total Demand All known position hours for projectsincluded in
the report.

Filled Demand Of the total demand, the number of position hours

that already have resource hours assigned to them.

Position hours that do not have any resource hours
assigned are considered unfilled demand.

Total Demand - Filled Demand = Unfilled
Demand.

Filled Demand Ratio Filled demand as a percentage of total demand.

Fillable Demand Of the unfilled demand, some position hours have
resource hours that are eligible to fill the demand
(based on matching criteria), but haven’t been
assigned, yet. These position hours are called
fillable demand.

Fillable Demand Ratio | Fillable demand as a percentage of total demand.

Unfillable Demand Of the unfilled demand, the remaining position
hours that do not have eligible resource hours are
called unfillable demand.

Unfilled Demand - Fillable Demand = Unfillable

Demand.
Unfillable Demand Unfillable demand as a percentage of total
Ratio demand.

Report calculations show Unfillable Demand + Fillable Demand + Filled
Demand = Total Demand.

|E The results for unfillable demand are important because they indicate that
you need to contract, hire, or train resources to meet this demand.
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In addition to unfillable demand results, a demand report is useful for making

sure project assignments are being made on atimely basis. A project that has

only 50% of the resource hours assigned, might be okay if the project start dateis

more than a few months out, but signals a problem if the start date is nearing.

The end of the report lists the parameters you selected to create the report.

Z} E¥_CapacityPlanning - Microsoft Internet Explorer
Fage ENN o3 MEE3E| Search Download/Print

NavBar First Prev Hext last Goto

June
Kirow
Analyst o 176 o 176 100.00% 0.00%
Comsultant o 176 o 176 100.00% 0.00%
Dev Engineex 176 176 o 352 £0.00% 0.00%
Q4 Engineer o 352 176 518 100.00% 33.33%
Engineering Manager o 176 o 176 100.00% 0.00%
Q4 Manager 176 176 o 352 £0.00% 0.00%
Location Totals: 352 1232 176 1760 80.00% 10.00%
Parameters
View Parameters Selection Parameters
Include Inactivity Commitments:  Firm Only Project Pools: L Project Pool
Period View: Sub-Period Praojects:
Analyze (SupplyDemand): Demand Resource Pools: L Resource Fool

Figure 3-4

Parameter Summary at End of Report
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3.3.3  Supply Report

A supply report shows capacity planning issues in terms of how resource hours
can be used. Thefirst page of the report shows a summary chart with the critical
surplusinformation included. Additional report pages show a detailed table of
report data sorted by job title and location.

Information in a supply report includes:

Column Description
Total Supply All known resource hours for resources included
in the report.
Used Supply Of the total supply, the resource hoursthat are
aready committed.
Resource hours that are not committed are
considered unused supply.
Tota Supply - Used Supply = Unused Supply.
Used Supply Ratio Used supply as a percentage of total supply.
Usable Supply Of the unused supply, some resource hours have

corresponding position hours that they would be
eligibletofill (based on the matching criteria), but
haven't been committed, yet. These resource hours
are called Usable Supply.
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Column Description

Usable Supply Ratio Usable supply as a percentage of total supply.

Unusable Supply Of the unused supply, the remaining resource
hours do not have position hours they are eligible
tofill. These resource hours are called Unusable
Supply. Unused Supply - Usable Supply =
Unusable Supply.

Unusable Supply Ratio | Unusable supply as a percentage of total supply.

Report cal culations show Unusable Supply + Usable Supply + Used Supply =

Total Supply.

The results for unusable supply are important because they indicate you
do not have position hours to assign to these resources.
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34 Using the Capacity Planning Analytic

The CP analytic provides enterprise-wide analysis of supply and demand futures.
The system cal cul ates the probability of aresourceto fill open positions. The
table of probahilities between each resource and open positionsis used to
calculate weighted average for gaps on both resources and positions.

With the CP analytic, you can compare multiple dimensions as desired and
perform “what if” planning scenarios.

Time (By Calendar)| 2004 ~
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! 02410

Bond, Jamas 1,512.00 1,512.00 584
White, Lora 1,512.00 1,512.00 584
[ Resource Pool 78,6240 846408 BRE4TEY  303RC | 5o
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el e, ) 1,512.00 5600 5600 584
e S 1,512.00 21601 1,285 98 584 1 500
S R 1,512.00 21601 1,285 98 584
St e 1,512.00 804.00 EO08.00 584

; 1,512.00 21601 1,285 98 584
Blue, Nata 151200 756.00 756.00 58474 1,000
Blue, Sharan
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0 T | E—
Total Supply Unusable Suply
Usshle Supply

Figure 3-5 Capacity Planning Analytic

As part of the standard Bl analytic application, the CP analytic includes all
associated Bl features such as member and data filtering, rearranging rows and
columns, changing presentation layouts, saving to Excel or PDF, and so on.

For alist of dimensions and measures, see “ Capacity Planning” on page 51.
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3.5 Changing the Matching Model

Capacity planning results are based on the matching criteria configured for your
enterprise. This criteria determines the likelihood of a given resource to fulfill a
given position definition. System administrators can modify this criteriato be as
strict or as liberal as desired.

3.5.1 Team Builder Settings

The criteria used to match resource hours to position hours is based on values

entered in Primavera operational applications. The capacity planning leverages

information from the following sources:

+ Default system options for team builder determine the project-to-resource
matching criteria.

+ Available project and resource hours are determined by work week and
holiday schedule definitions.

+ Existing resource-to-project assignments are included in the calculations.

System administrators can change this criteriato meet the specific needs of your
enterprise. To maintain consistency across projects, only the global default values
are used for capacity planning. See the Configuration Guide for more
information on setting team builder options.

System options for team builder include:

¢ Match Threshold. Determines the minimum match percentage required to
return aresource match. Raise the threshold to reduce the number of matches
returned.

+ Factor Weighting. Determines the relative weight of availability, job, and
qualifications when determining suitability.

+ Qualification Type Weighting. Determines the relative weight of
education, certifications, and skills when determining suitability.

If the qualification suitability score is less than the threshold, avalue of zero
(0) is used. Otherwise, the actual score (divided by 100) is used. For
example, 65%.
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3.5.2 Data Mart Properties

For the CP analytic, you can set key matching criteriain the Data Mart properties
file. You can also set limits on the number of matches created for resources and
positions.

Key Matching

To configure Data Mart for key matching, system administrators can change the
following property in the datamart.propertiesfile:

primavera.datamart.capacityplanning.model=LOCATION;
RESOURCEPOOLS ; JOB_TITLE

Keys you can match include:

Syntax Description
LOCATION Financial Location
RESOURCEPOOLS Resource Pools
DOMAIN Domain
QUALIFICATION Qualification
ORG_UNIT Org Unit
JOB_TITLE Job Title
CLASSIFICATION <NAME> | Classification

If both the Resource Pools and Domain keys are set, Resource Pools will be used
instead of Domains.

When specifying a classification in the capacity planning model, <NAME> must
be with the exact value (including spaces) substituted exactly as defined in its
primavera.datamart.classification.name.nn parameter.
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For example, if you had:

primavera.datamart.classification.name.l = "Abc*Def"

Then, the capacity planning model entry is:
CLASSIFICATION "Abc*Def"

Classifications can only be used if available both on resources and positions.

Capacity Planning only attempts to allocate demand or supply for a reasonable
number of positions or resources. By default, this number is set to 10.

If desired, you can add the following properties to override this default.

Maximum Positions Per Resource

primavera.datamart.ev populate supply fact.max
resources per position

This property sets the maximum number of resources that can match asingle
position. For example,

primavera.datamart.ev_populate supply fact.max_
resources _per position = 5

In this example, capacity planning ignores supply allocation for positions with
more than five suitable resources. The position will appear as unfillable in the
analytic.

Maximum Resources Per Position

primavera.datamart.ev populate supply fact.max
positions per resource

This property sets the maximum number of positions that can match asingle
resource. For example:

primavera.datamart.ev_populate supply fact.max positions
_per_resource = 5
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In this example, capacity planning ignores demand allocation for resources with
more than five suitable positions. The resource will appear as unusable in the
analytic.

Processing and Performance Issues

For performance reasons, Primavera recommends you keep the
max_positions per resource andmax resources per positon
properties set to 10 or less. Otherwise, ETL processing may take along timeto
complete.

However, if your matching criteria produces alarge number of matches for each
position or resource, settings of less than 10 may cause an incorrect number of
Unusable Supply and Unfillable Demand results to appear.

If the projects-to-resource or resources-to-project maximum is reached, a
warning message isissued at the end of ETL processing. Check the Data Mart
log file for this message. For example:

Data Mart processing for capacity planning has finished
successfully with the following warning: 23 Positions were
excluded from calculations....

The example above only shows the first few lines in the message. The
complete message will mention the location of a script.

To fix thiswarning, you can:

+  Run the script mentioned in the message to determine which positions or
resources were ignored. The script provides details about each position or
resource.

¢ Increase the maximum values set for the properties. Higher values will
increase ETL processing time, but fewer positions/resources will be ignored.

+  Further refine your matching criteria.

For example, if your matching keysinclude LocaTION, but location settings
for most of the resources and projects defined in the Primavera operational
applications are not filled in, you are more likely to produce alarge number
of matches and exceed the threshold.
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4. Access Control

This chapter describes how to set access control for the analytic applications.
Access control determines which PM and Bl features are available for users.
Topicsin this chapter include:

+ About Access Control

¢ TheAccessControl Interface

¢+ Managing Usersand Groups

¢ Portfolio Security
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4.1 About Access Control

Access to the analytic applications is maintained by a set of security roles. There
are two separate sets of roles:

+ PM Roles
+ Bl Roles

You can assign roles to individual users, or create groups of users and
collectively assign rolesto the group.

The analytic applications include an Access Control interface that enables you to
import users from the core application and assign security roles.

With Access Control, you can:

+ Import users from the core application

+ Manage user groups

+ Assign security roles to users and groups

¢ Disable or reenable user access

Users must be imported before they can access the analytic applications.

Once imported, users do not need separate logins to access PM and BI. Instead,
they are authenticated by the core application server.

The Administrator account is imported automatically from the core application
and given PM/BI administrator access. WebL ogic administrators are also
automatically given PM/BI administrator access.

Important: When single-sign on is disabled, there is no authentication
required to log on to PM and BlI, and all users are considered
Administrators. Single sign-on is configured during installation.

140 Analytic Applications



Access Control

411 System Level and Portfolio Level Access

PM roles can be assigned at two levels: system and portfolio. Bl roles are
assigned at the system level only. The first part of this chapter describes how to
assign PM and Bl roles on the system level. For information on setting PM roles
on the portfolio level, see “ Portfolio Security” on page 163.

When aPM roleis assigned at the system level, it grants the user privilegesto
perform al actionsthe role allows on all portfolios in the system. When the role
isassigned on the portfolio level, it grants the user privileges to perform all the
actions the role alows on that portfolio.

PM roles available for each level vary depending on the type of role. For
example, the Administrator role can be assigned only on the system level, but the
PM Owner role can be assigned on either level.

Access privileges granted at the system level cannot be removed at the portfolio
level. Primavera recommends you grant users a minimum of useful access
control at the system level, then add more extensive privileges on the portfolio
level as needed.

Users with no system-assigned roles cannot perform any actions unless
specifically granted arole on a portfolio. Users with portfolio level roles are able
tologinto PM only.
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The following table shows which roles can be assigned at the system and
portfolio levels. For adescription of each role, see“ PM Roles’ on page 143 and
“Bl Roles’ on page 144.

Role Name System Level Portfolio Level
PM Reviewer Yes Yes
PM Contributor Yes Yes
PM Owner Yes Yes
PM Publisher Yes Yes
PM Creator Yes No
PM Process Manager Yes No
Administrator Yes No
Bl Roles (al) Yes No
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4.1.2 PM Roles

PM supports the following roles:

*

PM Reviewer. Thisrole can be assigned at the system or portfolio level. It
grants users the privilege to view the contents of a portfolio, but not to
change it. For example:

¢ Userscannot add or remove charts and scorecards from the portfolio.
They cannot modify an existing scorecard layout.

¢ Users cannot modify or override portfolio constructs.
¢ Userscannot override KPI parameter values.

PM Contributor. Thisrole can be assigned at the system or portfolio level.
It grants users the privilege to modify portfolio contents, with the exception
of access control and membership. For example:

¢ Userscannot assign roles to users or groups within the scope of the
portfalio.

¢ Users cannot modify the membership definition of the portfolio.

PM Owner. Thisrole can be assigned at the system or portfolio level. It
grants users the privilege to modify portfolio contents, including access
control and membership. Owners can delete portfolios.

PM Publisher. Thisrole can be assigned at the system or portfolio level. It
grants users the privilege to publish portfolio views, such as scorecards and
charts.

PM Creator. Thisrole can only be assigned at the system level. It grants
users the privilege to create portfolios. When a user creates a portfolio, the
user is assigned the PM Owner role within the scope of the new portfolio.
This role does not provide access to existing portfolios.
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*

PM Process Manager. Thisrole can only be assigned at the system level. It
grants users the privilege to modify the “ process definition” features of
portfolio management. For example:

+ Userscan create, update, and delete KPIs.

+ Userscan create, update, and delete templates.

*  Userswith thisrole cannot perform any actions on portfolios (such as
viewing or modifying charts).

+  Define constants.

Administrator. Thisrole can only be assigned at the system level. Thisrole
allows users to perform any operation in both PM and BI. It also gives users
the ability to use the Access Control interface.

4.1.3 Bl Roles

In addition to the Administrator role mentioned above, Bl supports the following
roles:

*

Project Analyst. Thisrole is designed for users who monitor project
progress, including status and financial performance.

Forecast Analyst. Thisroleis designed for users who monitor project or
opportunity forecasts. Typically, thisroleis used in conjunction with the
Project Analyst role.

Resource Analyst. Thisrole is designed for users who require access to
resource status information, but not resource bill and cost rates.

Rate Analyst. Thisroleis designed for users who require access to resource
status information and bill and cost rates.

BI roles globally control which Bl analytics are available to users. When a user
has access to an analytic, all features and functions within the analytic are
accessible aswell.

All Bl roles are assigned at the system level. To access the Bl home page, users
must have at least one Bl role assigned.
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For custom analytics, users who have access to the original analytic used asa
baseline for the custom analytic will have accessto all custom analytics created
from this source. For example, if you open the Budget vs. Actuals analytic and
create a custom analytics named Projectl, all users who have access to the
Budget vs. Actuals analytic will also have accessto Projectl.

The following table shows which analytics are available to each role.

Role

Project Forecast Resource Rate
Analytic Analyst Analyst Analyst Analyst
Budget vs. Actuals Yes No Yes Yes
Capacity Planning No Yes No No
Pipeline Forecast No Yes No No
Project Commitment | No No No Yes
Project Expense Yes No Yes Yes
Project Financias Yes No No No
Project Forecast No Yes No No
Project Status Yes No No No
Project Time Report Yes No Yes Yes
Resource Summary No No Yes Yes
Resource Utilization No No No Yes

414  About Users and Groups

You can assign rolesto individual users or create users groups and assign rolesto
an entire group. Roles assigned to groups are by implication assigned to all users
in the group.
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Administrators can create any humber of arbitrarily-named user groups.
Administrators can add users to any number of groups. Users are not required to
belong to Administrator-created groups. They can have roles assigned directly.

Roles across groups are additive. For example, if auser belongsto a Sales
Planning group that has the Forecast Analyst role and the user also belongsto a
Finance group that has the Rates Analyst role, the user will have access
privileges associated with both the Forecast Analyst and Rates Analyst roles.

41,5 Change Propagation and Inheritance

Sometimes, changes to a user’s access control may not immediately propagate to
restrict their usage (for example, when you revoke access privilegesto a portfolio
or analytic that the user already has open). However, the system does enforce
current access control settings when a portfolio is opened or saved (for example,
the system checks access control privileges before letting a user save changesto a
portfolio).

If auser has privileges to view a portfolio of portfolios, but does not have
privilegesto view some of the lower-lever portfolios, that user can see:
¢ A summary of values for each KPI of the portfolio.

+ KPI valuesfor individua portfolios only if they have view privilegesto the
individual portfolio.

¢ Thenames of individual portfolios, regardless of access privileges.
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4.2 The Access Control Interface

4.2.1 Login

To open Access Control, enter its URL in a supported browser. ThisURL is case
sengitive and follows the format:

http://[HOST] /EA/Configuration/Configuration

where [HOST] isthe name of the computer where the Access Control web server
resides. If your enterprise relies on Secure Socket Layer (SSL) encryption, the
protocol, or first part, of the URL must be HTTPS. For example:

https://[HOST] /EA/Configuration/Configuration

A login page appears. Enter avalid username and password. This isthe same
username and password you use to login to the core application.

Click to show
B groups defined
rour: [Evenere = G G ﬁ i for the analytic

applications.

File

Imported users
are listed here.

Figure 4-1  Access Control Home Page

When you launch Access Control, it appearsin a new window. You can close the
original window at any time after the Home page appears.
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After installation, you must be an Administrator in the core application to use
Access Control for the first time.

When you first login, the home page includes a single, default user group,
Everyone, and asingle user, Admin. All usersimported into the analytic
applications are members of the Everyone group.

The following controls are available on the home page to create user groups,
assign roles, and import users. Each of these tasksis described in detail later in

this chapter.
Item Description
Group: [EUG VERIFICATION -] Groups drop down. Click to display alist of

groups

2

Edit Group button. Select a group from the
Groups drop down, then click Edit Group to add
or delete roles assigned to the group

Create Group button. Click to create a new group.

b | &2

B
b

=h

Delete Group button. Select agroup from the
Groups drop down, then click Delete to remove
this group. Usersin the deleted group lose role
assignments associated with the group, but remain
in the Everyone group. (You cannot delete the
Everyone group.)
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Item Description
T Add Users button. Select agroup from the Groups

‘I‘:@ drop down, then click Add Usersto add usersto
the group. Only imported users appear in the Add
Userslist.

¥ Import Users button. Select a group from the

‘l?ﬁﬁ Groups drop down, then click Import Usersto

import users into the group.

You cannot delete an imported user, but you can disable a user’s access |E
to the analytic applications. For more information, see “Editing Users”
on page 158.
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4.3 Managing Users and Groups

Primavera recommends the following procedure for importing users and
assigning them to groups. Each of these stepsis described in detail in the
following sections.

1. Plan and create groups

2. Assignrolesto groups

3. Import usersinto groups

Administrators can control which users are imported by their core application

access role and name. During import, you can automatically add the usersto
groups. Only imported users can log in to the analytic applications.

Usersimported from the core application retain their associated core application
role assignments. PM and Bl roles are added to these assignments.

Primavera recommends only importing users who require access to PM and Bl.
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4.3.1 Planning Groups

Groups provide a powerful tool for associating roles with users. The following
are some things to consider before creating groups:

*

Examine the accounts and access roles defined for your core application to
seeif you can create compatible role assignments and groups for the analytic
applications.

Remember thereis a trade-off associated with creating groups. A large
number of groups could provide more flexibility, but might also require
more maintenance.

Group names must be unique.

Groups cannot be included in other groups.

Because users can belong to more than one group, be careful about how you
allocate access control across groups. The Access Control interface does not
provide away to view role assignments across groups or a summary view of
system level vs. portfolio level role assignments.

Excessively-complicated role assignments might impact system
performance.
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4.3.2 Creating Groups

By default, Access Control includes the Everyone group. Usersimported into the
analytic applications are automatically members of this group.

To create a new group: %
1. Onthe Access Control home page, click ™ (Create Group).
A New Group pane appears.

2. Enter aname for the group.

Iy - Enter aname

Name: [6A Test for the group.

Roles:

‘% )— Clicktoadd
rolesto the
group.

Select Roles

Aiisuat .
Forecast Analyst — 1 Sdect the
rolesyou
want to
Project Analyst
s add and
click OK.

utor
PM Creator
Fid O

l Cancel ] I OK l

Figure 4-2  Creating a New Group

3. Click Add.
A list of roles appears.
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4. Select the roles you want to associate with the group, then click OK.
The New Group pane is updated to show the roles you have added. You can

continue to add or remove roles as desired.

Name: [ Test

Roles:

Roles
associated
with the

group.

Toremove

][ oK

[ Cancel

arole
froma
group,
click
Remove.

Figure 4-3  Roles Associated with a Group

Roles that have been assigned at the portfolio level do not appear in the
Access Control interface. To create and view role assignments at the

portfolio level, see “Portfolio Security” on page 163.

5. When you have finished assigning roles to the group, click OK.
The new group you created is saved and the name appears on the Groups

drop down.

6. Repeat this procedure for each of the groups you want to create. When you
have finished creating groups you are ready to import users and add them to

the groups.

Analytic Applications 153



Access Control

4.3.3 Importing Users

Users must be imported to access PM and BI. You can import individual users or
collections of users. You can select users to import based on their user names or
on their core application access roles.

To import users: ¥
1. Onthe Access Control home page, click @ (Import Users).
An Import Users pane appears.

Import Users - Criteria o
User Name: | Steps:
) 1. Criteria
Role Name:l Z. Results
l Cancel ] l Next

Figure 4-4  Importing Users

Use this pane to specify the types of users you want to import and the groups
that will include the users.
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2. Specify the search criteria for users you want to import.

+ User Name. You can enter a specific user namein thisfield, or you can
enter criteriathat appliesto acollection of users. For example, type Cto
display al users whose names include the letter C.

+ Role Name. If desired, you can import users based on Access Rolesin
the core application. For example, you can leave the User Namefield

blank and enter an access role name to display all core application users
with that role.

3. Specify the groups into which you want to import users. (If you are not
working with groups, you can skip this step.)

You can import users into more than one group at atime. Imported users are
automatically members of the Everyone group.

¢ Click Add.
+  Select the groups you want to include, then click OK.
The groups you selected are listed on the Import Users pane.

Import Users - Criteria o

User Name: |sr

Role Name: |

Groups:
Name

Everyane
QA

QA Test

Steps:
1 A. Criteria
2. Results

Click to

_ add groups.

Groupsto

whichusers
will be
imported

Click to

s remove a

[ Cancel

] group.

|

Figure 4-5

List of Groups
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4. When you have finished specifying import criteria, click Next.

A list of users that match the search criteria you specified (User Name and
Role Name) appears.

Use the checkboxes to select the users to import.

.
Click to
select all. —— FIIIC = (T
r =sr1 ASR1, ASRY D) 2. Results
I =2 ASR2, ASRZ
% ect the 5 =13 ASRI, ASRI
r =rs ASRS, ASRS
usersyou r =r1 SR1, SR
want to ~ 4 SR, SR
i mport r =5 SRS, SRS
r SkUsRes3 SkUsRes3, SkUsRes3
r DB_ResRate DB_ResRate, DB_Reshate
=
-
Figure 4-6  Selecting Users to Import

5. When you have finished selecting users to import, click Finish.

The users you selected are imported into the groups you specified on the
Import Users pane.
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6. To confirm your changes, you can select a group from the Groups drop
down to view usersincluded in the group.

File

Roles: Forecast Analyst, PM Reviewer, PM Process Manager
Users:

Nama

Figure 4-7  Viewing Users in Each Group

Once imported, you cannot delete users, but you can move usersto other groups,
add rolesto individual users, and disable user access. See “Editing Users’ on
page 158.
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4.3.4 Editing Users

Once you import a user, you can use the Edit User pane to:
+ Assign additional rolesto the user

+ Add (or remove) the user from groups

+ Disable (or reenable) access to the analytic applications

To edit a user:

1. Locatethe user you want to edit.
Select the Everyone group to view alist of all imported users, or select
another group to display users on a group-by-group basis.

2. Click Edit next to the user’s name.

I Select agroup to display a

oo [Ermre 2] 0 G0 BB e e list of usersincluded in
W % % b the group.

i .~ Toview or changeroles
it and groups assigned to a
= user, click Edit.

Gowom
B

il
o
=3

Figure 4-8  List of Imported Users
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A pane appears with alist of roles and groups assigned to the user.

Name: |35I’2

User enabled: | Yes =

Roles:
Name Action [=]

— 1 arde

Clicktoadd

Roles

assigned to
the user

L Click to add
agroup.

Groups
assigned to
the user

[ Cancel ] [ oK ]

Figure 4-9  Editing Users

The Access Control interface only shows roles assigned at the system

level. To create and view role assignments at the portfolio
“Portfolio Security” on page 163.

level, see
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Additional tasks you can perform with this pane include:

Task
Add arole

Description

Click Add next to the list of roles. New roles you
add are applied in addition to the roles the user
inherits as a part of group membership.

Remove arole

Click Remove next to the role. You can only
remove roles that are assigned individualy, (not
inherited as part of a group). To remove roles that
auser inherits as part of agroup, remove the user
from the group.

Removetheuser froma
group

Click Remove next to the group. Thisremovesthe
user from the group; it does not remove the group.

Add the user to anew
group

Click Add next to the list of groups.

Disable/Enable access

You cannot delete imported users, but you can
disable access to the analytic applications by
choosing No from the User Enabled drop down.
You can reenable users by choosing Yes.
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4.3.5 Editing Groups

Once you create groups and import users, you can edit groups to do the
following:

+ Add (or remove) imported users from the group
+ Add (or remove) roles associated with the group

To edit a group:
1. Select the group you want to edit from the Groups drop down.
A list of users and roles associated with the group appears.

Select agroup.

[
. Ly V- =
Roles associated | s=/mr =16 i & & i
Wlth the group N | pojes: Forecast Analyst, PM Reviewer, PM Process Manager

Users:

Name

Usersincluded in :
the group aer3 £t Ramous

Figure 4-10 Group Members

2. Toremove users from the group, click Remove next to the user.

3. Toadd usersto the group, click Add User s on the Access Control home
page.
A list of users appears. Only imported users appear on thislist.

4. Select the users you want to add to the group and click OK.
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F-d

5. Toadd (or remove) roles associated with the group, click @ (Edit
Group).

The Edit Group pane appears.

Edit Group - QA Test

Name: [0A Test

Rotes: Click to add
- arole.

Click to
remove arole.

Figure 4-11  Adding and Removing Roles in a Group

6.  When you have finished editing roles for the group, click OK to dismiss the
Edit Group pane.
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4.4 Portfolio Security

This section describes how to set access control on the portfolio level. Only the
following roles can be assigned; all other roles must be assigned on the system
level.

¢ PM Contributor

¢ PM Owner

¢+ PM Reviewer
You use PM (not Access Control) to set portfolio level security.

Portfolio level roles are assigned one portfolio at atime and are associated with
the portfolio. For example, a user who has a Portfolio Owner role on the system
level can perform Portfolio Owner tasks on all portfolios. However, a user who
has a Portfolio Owner role assigned on the portfolio level can only perform
Portfolio Owner tasks on the portfolio where the role was assigned.

If a user has privileges to view a portfolio of portfolios, but does not have
privileges to view some of its member portfolios, the user still sees
summary KPI values (and the names of individual portfolios) regardless of
access privileges. For more information, see “Change Propagation and
Inheritance” on page 146.

4.4.1 Opening the Portfolio Security Pane

To open the Portfolio Security pane:
1. Loginto Portfolio Management as an administrator or the portfolio owner.

You must be an administrator or the portfolio owner to set security for the
portfolio.
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2. Start PM and open a portfolio.
For more information about PM, refer to the Portfolio Management Guide.

3. Select File » Portfolio Security.

Welcome to Portfolio Management

Portfolio Management offers high level views of resources and projects, and
provides analytical tools to help you model your strategy. Open an existing portfolio
or click New to create one

Select a Portfolio to Open:

EMEA Projects

Al Besources NG EYED p f | .
Edit  Wiew  Tools
Mew... L«: Group By: @
Open... set Scorecard x| [Mane 3|
Save
Save As...
T Client Pool Org Unit
Revert
ects
Print to PDF...
B R thac L Project Pos! ——
Save View as Template. .,
Mac ABC Project Pool San Francisco
Compare Partfolios bnt Canada client CAD Project Pool San Francisco
22 Toor Client 22 Toor Project Pool Jones
Selecttoset — Lproect oo
S&unty for the DotCarm CAD Praject Poal TORONTO
Ortfol io (i ARGON TK Project Paal uUsa Organization
p . e Copy Alleg L Project Poal Org_A
I3 daveM Project JohnDoe client  TK Project Pool San Francisco
2 DProject2003 SITRO ABC Project Pool San Francisco
I3 Eagle Canada client CAD Project Pool Bostan
I ExpenseReports Mac L Project Paal Sul

Figure 4-12 Opening Portfolio Security
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The Portfolio Security pane appears. Use this pane to:

+ Add groups and users who will have portfolio level access.

+ Assign portfolio security roles to each group and/or user.

Groups:
Name Action [<]

Portfolio Security

{ Cancel ] I 0K

This pane
shows
groups that
have access
to the
portfolio.

This pane
shows
individual
users who
have access
to the
portfolio.

Figure 4-13 Portfolio Security Pane

44.2 Adding Groups and Users

To add groups and users:
1. Toadd groups, click Add next to the Group pane.

A list of all groups created for the analytic applications appears.
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2. Select the group (or groups) you want to grant portfolio access and click
OK.

Use Shift-Click and Ctrl-Click to select more than one group.
The groups you select appear on the Portfolio Security pane.

Portfolio Security

Groups:
Name Action [<]

Click toadd
groups.

= Then, select
the groups
you want to
add.

Select Groups

E vanone

Portfolic Security

o

*

o

&
[
&
=
2
&
|3

Groupsyou —
add appear
here.

4
2
=
&
=
[
&
&

Figure 4-14 Adding Groups
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3. Toadd users, click Add next to the Users pane.

Portfolio Security

Groups:
Name Action -]
Testing Remove Edit
Users: Click to add
Name Action Status [<]
aémin P & Actve — 1 users.
Select Users
Portfolio Security
Groups:
Name Action -]
PA Testing Remove Edit
Users:
Usersyou Ramave s
add appear amess e
here Lhite . Edit Active

Figure 4-15 Adding Users

4. When alist of imported users appears, select the user (or users) you want to

grant portfolio access and click OK.

Use Shift-Click or Ctrl-Click to select more than one user.
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4.4.3  Setting Portfolio Level Security
After you add groups and users, you can set portfolio level roles for each.

Setting Group Security

To set portfolio security for groups:
1. Inthe Portfolio Security pane, click Edit next to a group.

The Edit Group pane appears. This pane shows roles assigned to the group.
Both Bl and PM roles are shown.

Click to edit
Groups: portfolio
security for
PortoioSuparusa Remove et the group.

Click to add
portfolio
level roles.

Figure 4-16 Portfolio Security for Groups

2. Toadd aportfolio level role, click Add.
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When you add arole to the group, al usersin the group are granted access
privileges associated with the role. For example, assigning a PM Reviewer
role to the group gives all members of the group privileges to review the
portfolio.

3. When alist of roles appears, select the roles you want to add and click OK.
Roles you can assign on the portfolio level areincluded in the list. Use Shift-
Click and Ctrl-Click to select more than one role.

The roles you added appear in the list of roles for the group. Notice that
portfolio level roles can be removed in PM, but not system level roles.

Edit Group - PortfolioSuperuser

Name;lPunfo\iuSuperuser

Roles:

System|evel B

roles ——[™>
Portfolio PM Reviewsr Rmerrny

level role

Portfolio level roles (but not system level roles)
can beremoved in PM.

Figure 4-17 Adding Portfolio Level Roles for Groups

4. Click OK to exit the Edit Group pane.

5. Repeat this procedure for each group you have added to the Portfolio
Security pane.
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Setting User Security

To set portfolio security for users:
1. Inthe Portfolio Security pane, click Edit next to a user.

Portfolio Security

users: - Click to set user
security.

Edit User

Name: | alerking

User enabled: | ves -

Roles:

Name Action !
System level — [Fuoume
rol % Rate Analyst ‘
Click to add
Fgg?,l(;?es Select Roles
’ Groups:
PM Contributor

Everyene P Dwiner
PM Publisher
Testi
el P Fieviewer
PA Testing

[ Cancel ] i 0K

Figure 4-18 Portfolio Security for Users

170 Analytic Applications



Access Control

The Edit User pane appears. This pane includes the following information:

¢ User name. Thisisaread-only field.

¢ User enabled drop down. This setting cannot be changed in Portfolio
Management. For information on enabling/disabling user access, see
“Editing Users’ on page 158.

¢+ Roles. A list of system and portfolio level roles assigned to the user.
Only roles explicitly assigned to a users are shown here. Roles inherited
as part of group membership are not listed.

¢ Groups. A list of groups to which the user belongs.

2. Toaddanew role, click Add.

3. When alist of portfolio level roles appears, select one or more roles and
click OK.

Name: [alerking Portfolio level

user enablect [ = roles (but not
system level
roles) can be

removed in PM.

Figure 4-19 Adding Portfolio Level Roles for Users

4. Click OK to exit the Edit User pane.
5. Repeat this procedure for each user you have added to the Portfolio Security
pane.
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-5 PRIMAVERA

A. Data Mart

The analytic applications display datathat is collected in your enterprise’s
Primavera core databases. However, the applications do not directly read the core
databases. Instead, Primavera Data Mart extracts the data from the core database,
transforms the data for more efficient query, and loads the datainto a Data Mart
database and an OLAP (Online Analytical Processing) database. Data Mart may
also load some of the data from external sources, if your enterprise does not
implement Primavera Time and Expense or Delivery Manager. Once Data Mart
loads the data, the analytic applications read it from the cubes that constitute the
OLAP database.

Typicaly, DataMart isrun at frequent intervals so that the data are not so old as
to be misleading. However, the process can be time- and resource-consuming. A
typical enterprise may run Data Mart once a day, once aweek, or even less
frequently, depending on business and infrastructure policies. If you are
concerned about data freshness, you can change the frequency with which data
aretransferred, as described in “ M odifying the Schedule” on page 184.

This appendix describes:

¢+ Starting and Stopping Data Mart

+ DataMart Logs

+ Advanced Configuration of DataMart
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A1 Starting and Stopping Data Mart

The datamart process can be very time consuming, especially for large databases
and enterprises that use Primavera Time and Expense. For example, for atypical
large database, Data Mart may take six hours to run. Note, too, that the first run
of Data Mart takes a full snapshot of the data and will take longer than
subsequent runs. Subseguent runs perform incremental updates by only
extracting data that has changed.

To determine whether the datamart process compl eted successfully, run the query
described in “DataMart Logs’” on page 180.

Note that The Remote Registry Service must be running on every computer
hosting the Microsoft Analysis Services components. Refer to the System
Administrator Guide for more information.

A.1.1  Starting the datamart Process

During the startup, Data Mart verifies that the core database is compatible, and
stopsif it is not. However, Data Mart does not verify that the Delivery Manager
and core databases are synchronized. Verify that PYDB and DMDB are
synchronized if you implement Delivery Manager. For moreinformation, refer to
the System Administrator Guide.

Note that the Windows user that runs the datamart process must be defined as an
OLAP administrator on the computer hosting MS Analysis Services. For more
information, refer to the System Administrator Guide.

By default, the datamart process runsin continuos mode and transfers data based

on the schedul e specified in the Data Mart scheduler. You can start the datamart

process in standalone mode via the command line when you want to:

+  Override adatamart property on a one-time basis, such as forcing afull
snapshot data transfer in between scheduled runs.

+ Schedule data transfers using an OS scheduler, such as Microsoft Scheduler

For information on setting up data transfer schedules using the Data Mart
scheduler, see “Modifying the Schedule” on page 184.
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Starting the datamart Process in Continuous Mode

To start the datamart process, run the datamart . bat (in Windows) or
datamart . sh (in Solaris) file found in the <DATAMART>\bin directory. Open a
command prompt window, change directories to the <DATAMART>\bin
directory, and enter the following:
¢  Solaris:

./datamart.sh
¢+ Windows:

datamart

In Windows, the datamart process can also be started as a service. The serviceis
installed with the name “ Primavera DataM art Service” and is configured to be
started manually. To start the service, open the Services window by clicking
Sart » Programs » Administrative Tools » Control Panel, and double-click
the Servicesicon. In the Services window, select the PrimaveraDataMart Service
and click Start. You can aso start the service from the command prompt using
the following command:

net start “Primavera DataMart Service”

If you want the service to start automatically when Windows starts, change the
service's Sartup Typeto Automatic in the Services window.

You cannot have more than one instance of the datamart process running
against the same target database. Data Mart does not detect other
instances.
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Starting the datamart Process in Standalone Mode

You can run the datamart process in standalone mode via the command line if
you want to override properties stored in the Data Mart propertiesfile. For
example, you may want to force afull snapshot transfer of datain between
normally scheduled data transfers.

To run the datamart process in standalone mode:
1. Stop the current, continuous process.

2. At the command line, start the standalone datamart process once using the
following syntax:

datamart -<propertyls> <value> -<property2> <values>...

For example:

datamart -primavera.datamart.runonce.enabled true
-primavera.datamart.fullsnapshot.enabled true
-primavera.datamart.exeditedJobs FullTransfer

The primavera.datamart.runonce.enabled property runs the process
in standalone mode. If it is not specified, the process runs in continuos
mode.

3. When the transfer is complete, restart the process to run in continuos mode.

If you want to run the datamart process continuously in standalone mode
as part of the OS scheduler, add the standalone commands to a batch file
or script. For more information on the Data Mart scheduler, “Modifying
the Schedule” on page 184.
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A.1.2  Stopping the datamart Process

If you started the datamart process manually from a command prompt, thereisno
separate command to stop it. To stop the process, select the window in which you
started it, and press Ctrl-C. The datamart process stops and cleans up before
exiting.

In Solaris, Ctrl-C isthe only way to stop the datamart process.

In Windows, if you started the datamart process as a service, open the Services
window by clicking Start » Programs » Administrative Tools » Control
Panel, and double-clicking the Servicesicon. In the Services window, select the
Primavera DataMart Service and click Stop.

To stop the service from the command prompt, enter the following command:

net stop “Primavera DataMart Service”
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A.2 Data Mart Logs

Several logs are generated when the datamart process runs:

¢+ TheDataMart.log file is written to the <DATAMART>\ 1ogs directory. It
contains a copy of the text written to the console.

¢ TheOLAPIlogiswritten to <DATAMART>\1ogs\PvOlap.log.
¢ Thedj_log.txt found in the <DATAMART>\1ogs\et1 directory contains
some additional information logged by Data Mart's ETL tool.

In addition to the log files, Data Mart writes messages and errors, including those
encountered when external data was |oaded, to atable in the Data Mart database.
After you start the datamart process, you should monitor thistable, particularly if
thisisthe first time Data Mart has run, or if you have encountered problems.

Each time Data Mart runs, it writes the message:

Begin Transform Process

When the process ends, it writes the message:

Finish Transform Process

To view the contents of the table:
1. Runthefollowing query:
+ InMicrosoft SQL Server SQL Query Analyzer:

SELECT
substring (PROCNAME, 1, 40),

STARTTIME,
ENDTIME,
NUMBERRECORDS,
MESSAGE

FROM DATAMARTETLPROCESSLOG
ORDER BY MODIFIEDDATE
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¢+ InOracle SQL*Plus:

SELECT
substr (PROCNAME, 1, 40),

STARTTIME,
ENDTIME,
NUMBERRECORDS,
MESSAGE

FROM DATAMARTETLPROCESSLOG
ORDER BY MODIFIEDDATE

2. Review the results of the query.

The query returns alist of the most recent messages written to the table, similar
to the following:

ev_transform process
2003-02-28 10:24:49.207

ev_populate dimensions
2003-02-28 10:24:49.987
Dimension

ev_populate dimensions
2003-02-28 10:24:50.457
Dimension

ev_populate dimensions
2003-02-28 10:24:51.003
Dimension

ev_populate dimensions
2003-02-28 10:24:51.457
Dimension

ev_populate dimensions
2003-02-28 10:24:52.097
Dimension

2003-02-28 10:24:49.207

0 Begin Transform Process

2003-02-28 10:24:49.457
11 Populated Agency

2003-02-28 10:24:49.987
23 Populated Client

2003-02-28 10:24:50.457
211 Populated Resource

2003-02-28 10:24:51.003
44 Populated Opportunity

2003-02-28 10:24:51.470
143 Populated Project
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ev_populate dimensions 2003-02-28 10:24:52.097
2003-02-28 10:24:52.770 656 Populated Positions
Dimensions

ev_populate dimensions 2003-02-28 10:24:52.770
2003-02-28 10:24:52.770 0 Configured Company is
us

ev_populate dimensions 2003-02-28 10:24:52.770
2003-02-28 10:24:52.770 36 Selected Financial

Period only for US

ev_transform process 2003-02-28 10:24:49.207
2003-02-28 10:24:52.783 0 ev_populate_dimensions
complete

ev_populate contactdetails 2003-02-28 10:24:53.423
2003-02-28 10:24:53.423 0 Start of populate
ev_populate contactdetails 2003-02-28 10:24:53.423
2003-02-28 10:24:53.630 0 End of populate
ev_transform process 2003-02-28 10:24:52.783
2003-02-28 10:24:53.630 0 ev populate contactdetails

The errors and warnings that are written to this table are not written to the
console. If the message is an error, its Message column is prefixed with “Error.”
Errors may include problems Data Mart encountered trying to load external data
from the staging tables.
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A3 Advanced Configuration of Data Mart

You can change several aspects of the datamart process that were specified
during installation as well as several optional settings. To change these
properties, edit the <DATAMART>\cfg\DataMart .properties file or you can
override these properties via the command line. You must restart the datamart
process for your changes to take effect.

This section describes:

+ Modifying the Process L og Property

¢+ Modifying the Schedule

+ Loading Classifications

¢+ Changing Company, Exchange Rate Table, and Currency

¢ Extracting Full Snapshots of Data

¢+ Transferring Data lmmediately at Start Up

+ Modifying Scheduled Date Range (SDR) Expansion Period

¢+ Modifying the Fiscal Year

+ Disabling Functionality

For more information on changing datamart properties for Capacity Planning, see
“DataMart Properties’ on page 136.

A.3.1 Modifying the Process Log Property

Depending on the frequency with which data are transferred, the Data Mart’slog
table can become quite large. By default, log records older than seven days are
automatically deleted at the beginning of each run. Change the length of this
history by changing the following property inthe DataMart . properties file:

Primavera.datamart.DatamartETLProcessLog.purgeOlderThan
=7
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You can comment out this property if you want to permanently store all
messages. In this case, Primavera recommends that you regularly truncate the
table manually. For example:

TRUNCATE TABLE DATAMARTETLPROCESSLOG
A.3.2 Modifying the Schedule

A property inthe DataMart . properties file determines the frequency of data

transfer. The default schedul e transfers data every day at 12 AM. To change this

schedule, edit the DataMart .properties file and add the following property:
primavera.datamart.scheduler.<FullTransfer|
CapacityPlanning>.TimeExpression = <time expression>

The time expression format is similar to UNIX crontab format, but has two
additional arguments: Milliseconds and Seconds. These arguments are used at the
beginning of the expression:

Milliseconds Seconds Minutes Hours Days-of-month Months
Days-of-week

The valid ranges for each argument are:

Argument Valid Range
Milliseconds 0-999
Seconds 0-59

Minutes 0-59

Hours 0-23
Day-of-month 1-31

Months 0-11 or jan-dec
Days-of-week 1-7 or sun-sat

For example, the time expression:
0 0 15 8,17 * * mon-fri
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indicates transfer at 8:15 AM and 5:15 PM, Monday through Friday.

To express asymmetric schedules, supply the time expressionsin alist delimited
by pipes () and enclosed in parentheses. For example:
0 0 (30 0]45 13) * * =*

These time expressions transfer dataat 12:30 AM and 1:45 PM every day.

You cannot represent asymmetric schedules such as “every 12:30 AM
and every 1:45 PM” in a single time expression. The following expression
(though intuitive), will not work:

0 0 30,45 0,13 * * *

This expression transfers data every day at 12:30 AM, 12:45 AM, 1:30
PM, and 1:45 PM, instead.

A.3.3 Loading Classifications

By default, Data Mart does not transfer classifications. Classifications are
enterprise-specific categorizations of business objects. Classification types,
names, and possible values are defined at the enterprise level. For information
about configuring classifications, refer to the Configuration Guide provided with
the Primavera core application.

To transfer a classification, specify it in the
DataMart.properties file.

Primavera recommends transferring classifications sparingly, and
recommends that, once a classification has been transferred, it not be
deleted from the core application. If you must delete classifications after

they have been transferred, refer to “Deleting Classifications” on page

187.
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Specifying Classifications to Transfer

Identify each classification that should be transferred by adding a property that
follows this syntax:

primavera.datamart.classification.name.l = <name of
classification 1>

primavera.datamart.classification.name.2 = <name of

classification 2>

Note that each classification must be assigned a unique number, and that you
must not change this number after you run Data Mart.

After adding classifications to the DataMart .properties file, restart BEA
WebLogic.

Renaming Classifications

To rename a classification, it is not sufficient to rename it in the Configuration
application; you also need to remove it from the bataMart .properties file
and the Data Mart and OLAP databases by running a batch file.

To rename a classification:

1. Loginto the Configuration application, and edit the classification’s name.
For more information, refer to the Configuration Guide.

2. Using atext editor, such as vi or Notepad, open the
DataMart .properties file and replace the old classification name to the
new name you specified in the Configuration application.

3. Re-create the Data Mart and OLAP databases, as described in the System
Administrator Guide.

4. RunDataMart.
When Data Mart completes, the classification is renamed.
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Deleting Classifications

To delete aclassification, it is not sufficient to remove it from the core database
and the DataMart . properties file; you also need to remove it from the Data
Mart and OL AP databases.

To delete a classification:

1. Using atext editor, such asvi or Notepad, open the
DataMart .properties file and either remove or comment out the
classification you no longer want to transfer.

2. Re-create the Data Mart and OLAP databases, as described in the System
Administrator Guide.

3. Run DataMart.

When Data Mart completes, the classification is removed from the databases.
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A.3.4 Changing Company, Exchange Rate Table, and
Currency

Data Mart converts all monetary values referenced in the core application into a
single reporting currency. This requires an exchange rate table that converts each
referenced currency into the reporting currency. These values are supplied during
installation, but can be changed as the enterprise’s business changes.

To identify an exchange rate table for conversion to the specified currency, Data
Mart requires both the name of the table and the name of the company in which it
resides.

To set the company, exchange rate table, and currency:

1. Locate and openthepataMart.properties using atext editor, such asvi
or Notepad.

2. To specify adifferent reporting currency than USD, locate and edit the

primavera.datamart.reporting.currencyCode property:
primavera.datamart.reporting.currencyCode = USD

3. To specify the company that contains the exchange rate table, locate and edit
theprimavera.datamart.reporting.company property
primavera.datamart.reporting.company = <companys>

4. To specify the exchange rate table, locate and edit the
primavera.datamart.reporting.exchangeRateTable property:

primavera.datamart.reporting.exchangeRateTable =
<exchange rate table>

5. Save and closethefile.

These properties must be set in order for the datamart process to
complete.
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A.3.5 Extracting Full Snapshots of Data

A full snapshot of datais extracted after creating the target database. By default,
subsequent runs of the datamart process perform incremental updates by
extracting only data that has changed. To extract afull snapshot, edit the
DataMart properties file and change the following property to true:

primavera.datamart.fullsnapshot.enabled = true
A.3.6 Transferring Data Inmediately at Start Up

You can configure the datamart process to transfer the data once immediately
after the datamart process or service starts. Data Mart then continues on the
specified schedule. The primavera.datamart . startup.ExpediteJobs
property determines whether Data Mart runsimmediately. It also specifieswhich
job to include in the run.

If youusethe primavera.datamart .startup.ExpediteJobs property, you
must also set theprimavera.datamart . startup.LoadJobs property to load
the job before running it. For example:

primavera.datamart.startup.LoadJobs = FullTransfer

primavera.datamart.startup.ExpeditedJobs = FullTransfer

Job options include:
FullTransfer Thisoption runsastandard DataMart transfer.

CapacityPlanning Thisoption runs atransfer that includes data for
Capacity Planning.

To specify multiple jobs, use a comma-separated list. For example:

primavera.datamart.startup.LoadJobs = FullTransfer,
CapacityPlanning
primavera.datamart.startup.ExpeditedJobs = FullTransfer,
CapacityPlanning
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When running the process in standalone mode, you must specify the job
to expedite if it is not set in the properties file. Otherwise, the standalone
process runs in continuos mode. In standalone mode, you can expedite
only one job at a time. For more information on standalone mode, see
“Starting the datamart Process in Standalone Mode” on page 178.

For more information about the Data Mart schedule, see “ M odifying the
Schedule’ on page 184.

A.3.7 Modifying Scheduled Date Range (SDR)
Expansion Period

Data Mart does not transfer all the data from the core databases. One significant
limitation isthat Data Mart only transfers the resource commitment and position
schedule data from the date range you specify. Thisis because of the extensive
space required by the schedulesin their fully denormailzed format.

By default, the schedules are expanded from one year (365 days) in the past to
one year in the future. If these defaults are not appropriate, change the following
propertiesinthe DataMart . properties file:

# Start of the SDR expansion range in days (current day -
# minrange) .

primavera.datamart.SDRExpansion.minrange = 365

# End of the SDR expansion range in days (current day +

# maxrange) .

primavera.datamart.SDRExpansion.maxrange = 365

The values are expressed in number of days. You can decrease the range, but
doing so does not remove the data that are already in the database.

You must select a range that covers the entire period that may interest
your users. Otherwise, analytic application users will find zeroes for time,
rate, and cost fields when they examine data outside the period you
specified.
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A.3.8 Modifying the Fiscal Year

By default the Data Mart assumesthat the fiscal year starts on January 1, and that
each period in the OLAP cube will be prefixed with FY.

If these values are not suitable, you can change them by adding properties to the
DataMart .properties file.

When PM calculates a 13-period fiscal year, it creates thirteen 28-day periods,
which resultsin two extradaysin leap years and asingle extra day in other years.
Data Mart assigns the extra daysto the last period of the fiscal year. Note that the
fiscal year always begins on the specified day and month of the year, and is
labeled with the calendar year of the ending date. For example, if your fiscal year
ended on September 30, 2003, the fiscal year is numbered 2003.

To change the fiscal year configuration:

1. Using atext editor such asvi or Notepad, open the <DATAMART>\
cfg\DataMart .properties file

2. At the bottom of thefile, add a property called primavera.datamart.
FiscalYear.StartDate, and set it to the date upon which your
enterprise’s fiscal calendar begins. Enter the date in MM/DD format:

primavera.datamart.FiscalYear.StartDate=10/01
Note that thisvalueisarecurring date. This valueisused by enterprises with
a 13-month year to ensure that Primavera’s periods coincide their non-
calendar fiscal year. This property is used by the Time.Fiscal Year dimension
inthe OLAP cube.

3. At the bottom of the file, add another property called
primavera.datamart.FiscalYear.Prefix, and makeit equa to the
prefix Data Mart should append to each period in the Time.Fiscal Year
dimension in the OLAP cube:

primavera.datamart.FiscalYear.Prefix=FY

4, Saveand closethefile.

5. Stop and restart Data Mart. For instructions, refer to “ Starting and
Stopping Data Mart” on page 176.
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A.3.9 Disabling Functionality

To disable Delivery Manager or OLAP, edit propertiesin the
DataMart .properties file. Since Microsoft SQL Server is not supported in
Solaris, these properties should always be set to falsein Solaris.

Disabling DM

If you do not implement Primavera's DM functionality, you must disable DM in
DataMart, aswell. Set the primavera.datamart.etl.dm.enabled property
tofalse:

primavera.datamart.etl.dm.enabled = false

Disabling OLAP

Data Mart creates an OL AP database using Microsoft Analysis Services. If you
do not want to use this functionality or the analytic applications that rely onit,
disable OLAP by setting the primavera.datamart.olap.enabled property
to false:

primavera.datamart.olap.enabled = false
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Glossary
A

Access Control. The process of ensuring that the information within
Primaverais safe against unauthorized access. Security is based on Access Roles
and access policies.

Access Role. A set of accessrights (Privileges) granted to an account. Access
roles determine the information a user can view or modify.

Account. An established relationship between a person and an application.
Accessto dataand functionality islimited by the Access Role associated with the
account.

Agency. An external organization that supplies resourcesto the enterprise for
projects.

Agency Resource. A resource employed by an agency, and contracted to the
enterprise to perform project work. Sometimes called a consultant or contractor.

Allocation Policy. A configurable policy that dictates whether resources can
be assigned or reserved for more or different hours than the standard calendar
dictates.

Analytic Application. Generally, the term describes any software that helps
users visualize and manipulate business data to understand and control their
enterprise. In the Primavera context, the term “analytic applications’ refers
specifically to Portfolio Management (PM) and Business Intelligence (BI).

Assigned. When aresource is assigned, the period between the start and end
dates of the position is marked assigned in the resource's schedule. This affects
resource availability. An assignment to a project position commits that resource
to the position. Depending on configuration, the action of assigned may prohibit
aresource from being reserved or assigned to a different position during the same
time period.
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Authentication. The process of identifying an individual, based on alogin
name and password. In Primavera, authentication is distinct from access control.
Authentication ensures that an individual is who she claimsto be.

B

Browser. A software program used to view HTML documents and World Wide
Web pages. Primavera and its accompanying reports can be displayed in a
browser.

Budget. Projected figures for project cost and revenue, based on resource
reguirements, business roles, duration of need, and cost and/or billing rates.
Primaverauses thisinformation to formulate a cost budget or revenue budget that
is represented by fiscal period.

Business Object. A phenomenon tracked by the enterprise affecting project
decisions as they are represented in Primavera. Resour ce, Oppor tunity,
Project, Client, Competitor, and Agency are business objects.

Cc

CFYTD. Current Fisca Year to Date. When reporting financia information,
Primavera can gather and express project totals (such as revenue, cost, hours, and
expenses) in terms of various points of time. Other possibilitiesinclude | TD and
YTD.

Chart. A graphical representation of a portfolio. Charts include Bar, Stacked
Bar, Bubble, and Pie.

Classification. An enterprise-specific categorization of business object profiles
that is an alternative to the pool and organization structures. Depending on the
enterprise’s needs, classification types might include line of business, product,
market region, or any other alternate way of categorizing business objects.
Classification types, names, and possible values are defined at the enterprise
level.

Client. An organization for which aproject isundertaken. A client can either be
an external organization or an internal organization unit for which aclient profile
is created.
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Client Resource. A person who is employed by the client and can be assigned
to work on aproject. Client resources do not have profiles.

Commitment. A resource’s time commitment, such as project assignments,
travel, vacation, and leave of absence. These commitments are displayed in a
resource’s schedule. Commitments to a project fall into one of four actions:
Shortlisted, Reserved, Assigned, or Excluded.

Company. A predominantly independent division of the enterprise’s
Organization Structure that contain Organization Units. Financial
information defined for a company is used by its organization units to regulate
billing and Time and Expense reporting, and to default values for opportunities,
projects, and resources.

Competitor. A businessrival that competes with your enterprise for
opportunities and projects.
Consultant. See Resour ce.

Cost. The cost to the enterprise for goods and services. Costs are associated with
Resour ces, Non-resour ce I tems, Positions, Cs, and M aterial Resour ces.
Cube. A logical set of datathat is organized and structured in a hierarchical,
multidimensional arrangement. Cube dimensions allow usersto perform
complex analysis by simultaneously viewing a combination of factors. See also
dimension, measure, and member.

Currencies. One of the financial rules defined in the Primavera Configuration
application. Currencies are configured with exchange rate tablesin order to make
multiple currencies available to all companies within the enterprise.

D
DBA. Database administrator.

Data Freshness. The recentness of the datain a system. In PM, data freshness
is dependent on the frequency with which Data Mart is run.

Data Source Name. DSN. Specifies how aclient should connect to a
particular data provider.

Database Server. An application that allows you to modify, update, or create
records in a system of organized information (database).
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Denormalize. The process of expanding dataiin adatabase to its smallest useful
unit and propagating redundancy to facilitate reporting. It is the opposite of
normalize.

Dimension. A category used in an data cube or fact table used to organize
business data for retrieval and consolidation of values. Each dimension usually
contains a hierarchy of related members. For example, a Year dimension often
includes members for each time period, such as months and quarters.

E

Employee. A resource hired by and working for the enterprise.

Enterprise. The organization served by the application, i.e., your company. The
enterprise encompasses al business data in the application.

Exchange Rate Table. One of the financial rules defined in the Primavera
Configuration application. Exchange rate tables store exchange rates for unique
combinations of currencies and rate types.

Excluded. When aresource is excluded from a position, the resource cannot fill
this position for some reason. For example, if aresource you reserved for a
project had adisastrous interview with the client, you could exclude that resource
to ensure that he was not staffed to the position.

F

Filled. When a position is marked filled, aresourceisassigned to it during every
hour that it requires. If aposition isonly partialy filled, it is marked Open.
Filter. A tool, usually in the form of amenu, for selecting the types of itemsyou

seek. For example, you might use afilter to search only for projects that are
active.

Fixed Schedule Billing. A billing method based on a user-defined schedule of
amounts and dates. Fixed schedule billing is a set of dates and amounts that
define the invoices generated for the client.
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Functional Organization Structure. The organization structure that
represents the reporting relationships within your enterprise. This organization
structure reflects all or part of your organization chart and provides a framework
for financial configuration. In Primavera, the enterprise structure can consist of
companies and organi zations within those companies.

G

Group. To reorder the currently displayed data by rolling up all objects that
share avalue for aparticular KPI. For example, grouping a project portfolio
scorecard by the Client KPI reorders the data such that all projects for agiven
client are displayed in asingle row.

H

Host. The computer that executes a piece of software; the computer upon which
aparticular application runs.

ITD. Inception to Date. When reporting financial information, Primavera can
gather and express project totals (such as revenue, cost, hours, and expenses) in
terms of various points of time. Other possibilitiesinclude CFYTD and YTD.

Import/Export. The process of bringing external data into the application or
sending internal data out of the application.

Indicator. In aKPI, the combination of scheme, symbols, and labels that define
the graphical representation of a KPI's possible values.

Instance. An occurrence of an application in run-time. For example, an instance
of the Primavera application server is a single occurrence of the application
server software running on a host computer.

J

JDBC. Java Database Connectivity. A database access standard, JDBC allows
Java applications to access data, regardless of which RDBMS stores the data.
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K

KPI. Key Performance Indicator. A metric used to track and predict operational
health. KPIs describe specific aspects of projects or resourcesin terms of the
goals that comprise the enterprise’s strategy. KPIs can be used to compare
business objects to their objectives and to other business objects.

L

LDAP. A client-server protocol for accessing a directory service. A directory
service provides information about network resources or users. For example,
Netscape Directory Server and any Domain Name Server are LDAP servers.

MS SQL Server. A supported relational database management system
(RDBMS) developed by Microsoft that runs in Windows environments.

Manager. In the functional organization structure, the manager is the resource
whose name appears in the manager position for each organization unit.
Functional managers represent the managers in an enterprise’s organization chart.

Material Resource. The physical objects and expenses for which you track
costs, rates, and usage. Note that material resource are tracked separately from
resources expenses.

Measure. A value or set of values (usually numeric) stored in a data cube. For
example, Sales Price, Cost, and Profit could all be measures. Measures are the
central values that are aggregated and analyzed.

Member. A discrete component within a dimension. For example, a Location
dimension might include members such as Boston, Paris, or South America.
Membership. The resources, projects, or portfolios that appear in a portfolio.
Membership is either static or dynamically defined.

Multidimensional Expression (MDX). A complete query syntax used to

query and manipulate datain OLAP cubes. Portfolio Management supports
MDX in KPI definitions.
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N

Non-resource Account. An account manually created for individuals who
must use Primavera but do not have profiles.

Non-resource Item. Part of adelivery scenario and pricing model; a material
object or an expense for which the client can be billed.

0

ODBC. Open Database Connectivity. A database access standard. ODBC allows
applications to access data, regardless of which RDBM S stores the data.

Object Pool. A Pool that contains business objects (rather than pools or
accounts). Object pools can contain any number of objects of one type:
opportunity, project, resource, client, competitor, or agency.

Open. When a position is open, some portion of the hoursiit requiresis not
Filled by resources.

Opportunity. New business pursued by your enterprise. When an opportunity is
won, it becomes one or more Proj ects.

Oracle. A relational database management system (RDBMS) developed by
Oracle Corporation that runsin Windows and Unix.

Organization Structure. See Functional Organization Structure.

Organization Unit. Also Org Unit. A group of resources organized by some
similarity, such as job function. Organization units are arranged hierarchically to
form companies. Together, organization units and companies congtitute the
Functional Organization Structure.

P

People. See Resour ce.

Periods (financial). Part of the financial configuration, financial periods are
spans of time that are configured with certain categories and subperiods.
Financial periods typically mirror the company’s fiscal year.

Pool. A logical grouping of business objects or pools. Pools that contain
accounts are called domains. Domains can contain any number of pools and
accounts. Pools that contain business objects are called Object Pools.
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Pool Structure. The hierarchical structure of pools that represents an
alternative view of your enterprise. The pool structure contains Pools, domains,
Object Pools, Opportunity, Projects, Resource, Clients, Competitors, and
Agency.

Portfolio. A collection of resources, projects, or other portfolios that typically
share acommonality. For example, you might define a portfolio that features all
your implementation projects.

Position. Represents arelationship (Filled or Open) between aresource and a
project.

Privilege. Permission to take some action in Primavera.

Project. A temporary endeavor undertaken by the enterprise to create a unique
product or service for one or more clients.

Project Commitment. A relationship between aresource and a project
position for a specified period of time.

Project Currency. The currency in which budgeting and accounting are
processed.

Project Manager. An employee of the enterprise who is responsible for the
completion of one or more projects. In Primavera, a project manager is often an
owner of the project.

Project Owner. The owner of aproject. One or more resources can be assigned
as project owners.

Project Task. A day-to-day task assigned to one or more positions or resources
assigned to a project.

Project Team. A group of positions on a project that share some similarity,
such as schedule or job function.

Project Type. A categorization of projects that determines the staffing policy
and whether the project can or must have a parent.

Pursuit Project. A feature for defining detailed qualificationsin building a
team. The status of a pursuit project is active while the opportunity is open, and
complete when the opportunity is closed.
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Q

R

RDBMS. Relational Data Base Management System. An application that allows
you to modify, update, or create records in a system of organized information
(database).

Rate. The hourly cost to the client for the services performed by a resource.
Primavera tracks the following rates:

¢ A businessrol€e’s standard, minimum, and maximum rates.
+ A position’s actual rate.

+ A resource’s standard, minimum, and maximum rates.

¢+ Theratesapplied to material resources based on the usage.

Rate Range. The scope defined by the minimum rate and maximum rate
specified for a business role or resource.

Reserved. When aresource is reserved for a position, the period between the
start and end dates of the position is marked reserved in the resource’s schedule.
This affects resource availability. Depending on configuration, an action of
reserved may prohibit a resource from being reserved or assigned to a different
position during the same time period.

Resource. Anindividual represented in Primavera. Includes employee, agency
resource, and client resource.

Resource Account. An established relationship between aresource and
Primavera. A resource account, which is automatically created for aresource
when the resource profileis created, often has limited privileges in Primavera.

Resource Pool. A pool that contains resources. Resource pools determine a
resource's position in the pool structure, aswell as being referenced by projects
for staffing purposes.

Revenue Recognition. A manner of determining whether income has met the
conditions of being earned and realized.

ROI. Return on Investment. A comparison of benefitsto cost, typically

expressed as a percent of the total expenditure. An ROI calculation is used to
determine if a project achievesits goals to an extent that justifies the cost.
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Role. See Access Roles.

S

Scheduled Date Range (SDR). A position schedul e or resource commitment
schedule, asit is stored in a Primavera database. In the Primavera core database,
these schedules are stored in a condensed format. When they are transferred to
the data mart database, the data are fully denormalized. SDRs account for alarge
percentage of the data mart's database.

Scorecard. A tabular view of a portfolio that defines the KPIsto include and
the order in which to display them.

Security. See Access Contral.

Server. A computer on anetwork that manages data and processes requests.
Servers are accessed by Client.

Server Instance. A piece of server software executing on a host.

Service. A process that performs a specific system function and usually
provides an API for other processes to call.

Shortlisted. When aresourceis shortlisted for a position, the resource is
flagged to indicate that they are a potential candidate for the position. Thisaction
indicates that you are considering a resource for a position. When you open the
Team Builder with this position, any resources you have shortlisted are
displayed. Shortlists do not affect availability.

Star Schema. A plan for the datain an RDBMS that optimizes them for
reporting. The central feature of the schemais afact table that is surrounded by
denormalized dimensions, each of which is stored in a separate table.

System Administrator. An individual who must access configuration and
access control aspects of Primavera.

T

Template. A scorecard definition saved for use in other portfolios. A template
includes a name, description, and the KPIs included in the scorecard.
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Time and Expense. A feature available in the Primaveraweb client that
allows users to enter and approve time and expense reports. Time and expenses
can be entered on or offline. Approval is executed online only.

Time and Materials. Also referred to as T&M. A billing method based on
time, expense, and material resource transactions.

ToolTip. A small pop-up window that displays either the name of a user
interface element or further information about the field’'s value.

U

URL. Uniform Resource Locator. The globally unique address of a document or
other resource on the World Wide Web.

User. A person who has accessto Primavera. A user has either a Resour ce
Account or aNon-resour ce Account.

User Account. See Account.

Utilization. The percentage of total available billable hours during which a
resource is assigned to projects.

\'/
View. A Scorecard or Chart.

w

waterline. A visual modeling tool that force ranks resources or projectsinto two
groups by sorting and applying a constraining limit. The membersin the first
group (above the waterline) collectively meet the constraining value. All other
members appear bel ow the waterline.

Web Server. An application that fields requests for web content, including
HTML documents and Java applets.

Wildcard. A symbol used to represent unknown charactersin asearch. In
Primavera, prefix a search with %. Searches return objects that contain the letters
you specify. For example, %ram returns grammar, tram, and diagram.
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X

Y

YTD. Year to Date. When reporting financia information, Primavera can gather
and express project totals (such asrevenue, cost, hours, and expenses) in terms of
various points of time. Other possible termsinclude I TD and CFYTD.

z
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Index

A

access control
change propagation in applications 146
home page 147
inheritance 146
login 147
overview 140
URL 147
Seealsoroles.
Add Users button 149
administrator 140, 144
Adobe Acrobat Reader 8
Alphablox
database repository 17
analytic applications
databases 17
features and benefits 14
overview 13
Primavera application server 18
services 18
analytic reports 30

B

BEA WebLogic

administrator 140

as application server 18
begin transform process 180
Budget vs. Actuals analytic 30, 46

Business Intelligence
charts 34, 36
data options 42, 94
export to Excel 36
export to PDF 36
grids 34, 36
home page 33, 35
interface controls 34
list of analytics 30
login 32
menus 38
operational database 17
overview 28
presentation options 44
tool bar 35
URL 32, 125
views 36, 39

C

calendar year 88
capacity planning 7, 14, 113
calculation example 118
report 125
chart (BI)
options 43
dlider bar 110
types of 36, 43
viewing 36
collapsing, dimension hierarchy 40
command line 183
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company 188
Configuration
See also access control and roles.
Control key 85
control panel 177, 179
cost, and zero values 190
Create Group button 148
creating
custom analytics 79
user groups 152
crontab 184
cubes. See OLAP, data cubes
currency 188
custom analytics
accessing 31
changing data layouts 80
creating 79
deleting 105
example of 106
saving 35, 103

D

data dimensions
Budget vs. Actuas dimensions 48
Capacity Planning dimensions 52
filtering members 83
hiding 40
overview 28
Pipeline Forecasts dimensions 55
pivoting 40
Project Commitments dimensions 58
Project Expense dimensions 61
Project Financials dimensions 66
Project Forecasts dimensions 63
Project Status dimensions 69
Project Time Report dimensions 71
Resource Summary dimensions 74

Resource Utilization dimensions 77
time dimension 88

data layout, changing 80

Data Mart
and external data 175
asaservice 177, 179
classifications 185
date range 190
immediate transfer 189
log table 180, 183
overview 175
processing time 176
propertiesfile 183, 192
schedule 184
starting 176
stopping 179
update mode 189

Data Mart database
and the Data Mart 175
introduction 17
log table 180, 183
staging tables 25

Data Mart Service 179

data measures
Budget vs. Actuals measures 48
overview 28
Pipeline Forecasts measures 56
Project Commitments measures 59
Project Expenses measures 61
Project Financials measures 67, 70
Project Forecasts measures 64
Project Time Report measures 72
Resource Summary measures 75
Resource Utilization measures 53, 78,

79

data options, setting 94

data sources 24

data transformation 20

database authentication 23
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datamart process
continuous mode 177
datamart.bat file 177
DATAMARTETLPROCESSLOG 180,
183
DataMart.log 180
DataMart.properties
classifications 185
configuration 183
date range 190
disabling functionality 192
schedule 184
update mode 189
datamart.sh file 177
date range 190
delete
custom analytic 105
Delete Group button 148
Delivery Manager 175, 192
demand report, capacity planning 129
denormalized data 20
dimension hierarchy 40
dimensions. See data dimensions.
disabling functionality 192
dj_log.txt 180
Drill commands 37, 40

E

Edit Group button 148
EJB container 18
ETL 19, 175, 180
Excel 38
exchange rate table 188
expanding, dimension hierarchy 40
EXPEDITEJOBS property 189
export

to Excel 36, 38

to PDF 36, 38, 112

externa
budget data staging table 24
expense sheet data staging table 24
sources of data 24, 175
timesheet data staging table 24
transaction actuals data staging

teble 24
extract 175

F

filled and fillable demand 130
filled and fillable demand ratio 130
finish transform process 180

fiscal year 88

Forecast Analyst role 144, 145

G
grid (BI)
options 44
viewing 36
groups. See user groups.
|
importing data 24, 25
importing users 140, 149, 154
J
Java Server Pages (JSP) 18
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layout view 36

LDAP directory 23

load 175

LOADJOBS property 189
log 180, 183

mesasures. See data measures.
Member Filter 37, 42, 83
Microsoft SQL Server

log table 180
multidimensional modeling 28

(0

OLAP
data cubes 28
database 17, 28
disabling 192
loading 175
log 180
online documents 8
Oracle
log table 180

P

page view 36, 87
PDF files 8, 36, 38, 106, 112

Pipeline Forecasts analytic 30, 51

pivot data dimensions 40
PM and Bl services 18

PM roles

Contributor 143

Creator 143

Owner 143

Process Manager 144

Reviewer 143
portfolio level roles 141
Portfolio Management

operational database 17

roles 143
Primavera Data Mart Service 177
Primavera operational applications

database 17

print

online documents 8

to PDF format 112
project

denormalized schedule 190
Project Analyst role 144, 145
Project Commitments analytic 30, 57
Project Expense analytic 30, 60
Project Financials anaytic 30, 65
Project Forecasts analytic 30, 62
Project Status analytic 31, 68
Project Time Report analytic 31, 71
pvOlap.log 180

R

Rate Analyst role 144, 145
Redo command 35
reporting currency 188
resource

denormalized schedule 190
Resource Analyst role 144, 145
Resource Summary analytic 31, 73
Resource Utilization anaytic 31, 76
revenue, and zero values 190
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roles
Business Intelligence 144
Portfolio Management 143
system level and portfolio level 141
table of available analytics 145

S

Save As Custom button 35
scheduled date range 190
scheduling data transfer 184
setting the update mode 189
Shift key 85
Solaris

disabling functionality 192
staging tables 25
startup 176
stopping Data Mart 179
supply reports, capacity planning 132
system architecture 16
system level roles 141

T

time and expenses 175

time dimension 88

tool bar, in Business Intelligence 35
total demand 130

total supply 132

transfer immediately 189

transform 175

U

Undo command 35
unfillable demand 130
unfillable demand ratio 130
unusable supply 133
unusable supply ratio 133

URL
for Access Control 147
for Business Intelligence 32, 125
uUsD 188
used and usable supply 132
used and usable supply ratio 132
user authentication 22
See also roles and access control.
user groups 22
adding rolesto 153
adding usersto 149, 161
creating 148, 152
deleting 148
editing 148, 161
importing users 149, 154
managing 150
overview 145
planning 151
removing users from 161
users
adding to agroup 160
assigning rolesto 160
disabling access 160
removing from groups 160
removing role assignments 160

w

Windows
services 177, 179

yA

zeroesin data 190
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